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Chapter 1

Welcome to Sage Master Builder 
Installation
This chapter provides information about the following:

• Installation Overview

• Printed and Printable Documentation

• Customer Support Resources
1



Chapter 1
Installation Overview

Welcome to Sage Master Builder version 13 installation

Welcome all new and returning customers to Sage Master Builder 
version 13 installation. You have made a good decision to purchase Sage 
Master Builder, the premiere construction business management tool. 

We strongly recommend that you read the information contained in this 
book. Sage Master Builder can run in many different software and 
network environments, but there are important issues to take into 
consideration for each one. The more information you can gain about the 
installation process and how it relates to your software and network 
environment, the more likely your installation will proceed smoothly. 

Program Enhancements

What’s new in the latest release

For more information about each of these enhancements, see the “What’s 
new in the latest release” topic to in the program Help after installation. 

Program-wide drill down from reports

Sage Master Builder Version 13 features program-wide drill down 
functionality from most reports. You can run a report; and then from 
print preview, you can drill down to the data from which the report was 
built. In addition, most reports that you have edited or created using Sage 
Master Builder’s Report Writer have drill down functionality 
automatically. 

Email user authentication enabled

You can now set up your Internet service provider’s (ISP) simple mail 
transfer protocol (SMTP) server name along with your user name and 
password to send email from Sage Master Builder.

Importance level and read receipt functionality in email

When emailing with Sage Master Builder, you have the options to set the 
email message’s importance level and to request a read receipt. To use 
2
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these new features, however, your email service provider must support 
this functionality. 

Add additional email addresses to a message

To provide more flexibility when emailing, now you can select recipients 
from the distribution list and also add additional email addresses to 
messages.

Email option to “Send a copy to my inbox”

The Email Distribution window has a check box so you can send a copy 
of an outgoing email message to your return address. The body of the 
email message includes a list of all the contacts selected to receive the 
message as well as any additional email addresses entered manually.

Option to save the bank reconciliation report

A new option is available when saving the final bank reconciliation that 
allows you to save the report as a PDF file in case the report needs to be 
reviewed or printed later. 

Client entry now available for RFIs and Submittals

A client entry box has been added to 6-11-2 Requests for Information 
and 6-11-4 Submittals so that RFIs and Submittals may be addressed to 
clients. Entry in the Client and Vendor boxes on the 6-11-2 Requests 
for Information and 6-11-4 Submittals are mutually exclusive. Now 
you can save the records with a client or vendor, but not both. In 
addition, new reports and selection criteria have been added for RFIs and 
submittals. The “List by Job” reports now show the client.

Windows “Classic” theme is no longer required

Windows XP operating system used to require using the Window Classic 
desktop theme so that Sage Master Builder windows would not be 
clipped. Now you no longer need to use the Classic theme with any 
supported operating system, including Vista Business.

Help menu links to printable documentation

A new command, Printable Documentation, is on the Help menu on 
the Sage Master Builder main window to make it easier for you to locate 
3



Chapter 1
and print Sage Master Builder documentation that is in PDF format. For 
more information, see the Help topic “Printing Sage Master Builder 
printable documentation.”

Deleting subaccounts made easier

Previously, if you wanted to delete more than one subaccount for any 
given controlling account, you had to close the subaccounts window and 
re-open it so the Delete menu option became available again. Now you 
can delete as many subaccounts as needed without closing the 
subaccounts window between each one.

Easier access to the Sample Company

When opening the Sample Company, the User Name and Password 
window includes information stating that you can log in to the Sample 
Company using the user name Supervisor and that a password is not 
required.

More information now available about using the API

More information and two new topics are in the Sage Master Builder 
Help about using the Sage Master Builder API for integration with other 
products. The topics are named “Setting up a security group for using the 
API,” and “Setting up an API user and password.”

Help topics now include customer feedback links

Now you can submit opinions and comments about the usefulness of 
Help topics via links that are located at the end of each Help topic. You 
can submit a simple “Yes, this topic helped me,” or you can type and 
submit a comment by clicking the second link. Getting feedback from 
customers, business partners, and consultants will help guide future 
documentation enhancements.

Important: 

You must have the Adobe®Reader® installed on your 
computer to view and print Sage Master Builder guides. To 
download this free software for viewing and printing 
documents in PDF format, visit 
http://www.adobe.com/products/acrobat/readstep2.html 
4
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“Total Wages” column renamed “Wages”

In the program area of 5-5 Daily Payroll and Daily Job Reports, to 
improve drill down functionality and report accuracy, the Total Wages 
column has been renamed Wages and moved to a position after the 
Premium column. In addition, Other Wages has been renamed Other 
Pay and now includes Pay Types 8 and 9 (Misc. and Per Diem).

Sage Master Builder Enterprise Edition Installation 
Information

The Sage Master Builder Installation and License Administration Guide 
now provides information about Enterprise Edition installation. If you 
are an Enterprise Edition customer, the Enterprise Edition Guide appears 
in the 7-Utilities section of the in-product Help and the installation 
information is located in Appendix I.

More “How?” links in the Help to assist you to complete 
complex tasks

Some complex tasks require that you first complete several additional 
tasks as steps in the process of completing the original task. “How?” 
links in Help provide easily accessible links directly to these related 
procedures. Look for the “How?” links in procedural steps and other 
locations within Help topics.

Modifications to the “Fax Line Access” area

Modifications have been made to the Fax Line Access area on the 7-2 
Company Information window to improve usability.

Audit error detection reports

Several new audit error reports have been added to Sage Master Builder 
to help Customer Support technicians identify the transactions related to 
some audit errors. These reports will save time diagnosing the problem 
in the event you discover audit errors that require Customer Support 
assistance to repair.

Convenient access to the Remote Assist Tool

The Remote Assist Tool allows Sage Customer Support representatives 
to access your systems and data remotely through your computer to 
5
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provide support services to you and your company. During a support call, 
you can quickly access the Remote Assist Tool from a Help menu link on 
the Sage Master Builder main page. Select Help > Customer Resources 
> Technical Support > Remote Assist Tool.

Sage System Verification utility

The Sage System Verification utility is installed to the \Program 
Files\Common Files\Sage\SSV folder with each Sage Master Builder 
installation. This utility assists with troubleshooting hardware issues 
related to the Sage licensing component.

New PDF and RTF drivers

New versions of the PDF and RTF drivers are now installed with Sage 
Master Builder Version 13. The new drivers resolve some customer 
issues.

Information about the MB7Tax.dll file added to the Help > 
About window

The version information about the MB7Tax.dll file allows easy reference 
to the tax table file that the program is currently using when payroll is 
computed. 

Year-end Tax updates for Sage Master Builder Version 13 

Included are updates to federal forms and other government-mandated 
changes for the 2007 tax year. Also included are updates to state payroll 
tax tables and federal income tax effective January 1, 2008. 

For other details, on the main Sage Master Builder window, click File > 
Help > Printable Documentation > Release Notes. 

Read This Before You Install

Where do I begin?

Before you begin installing Sage Master Builder version 13, we 
recommend that you review this list. It provides some very basic 
information about what to do before you begin installing Sage Master 
Builder software. 
6
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1. Gain an understanding of what’s new about product installation by 
reading this book, by reading the QuickStart Installation Guide, and 
by reading the letter from your Business Partner.

2. Learn about the licensing process. Your Sage Master Builder license 
is managed by a the License Administration Tool and the Sage 
license server. 

3. Before you start installation, locate the license file (in an email 
message) or your printed product keys. To activate your license, you 
must import a license file or enter product keys using the License 
Administration Tool. 

4. If you are an existing customer, back up your company data before 
installing the software.

What information is in this book?

The rest of Chapter 1 “Welcome to Sage Master Builder Installation” 
provides more information about customer resources, such as:

• Other printed and printable guides

• The in-product Help system

• Contacts for Customer Support

• Sage Master Builder training

• Information about Business Partners and Sage Certified Consultants.

Chapter 2 presents technical information about “System Requirements 
and Configuration.” Sage Master Builder will not run correctly or not run 
at all on computers that do not meet the requirements, so before you 
install the software, be sure your computers meet the system 
requirements. 

Chapter 3, “Installing Sage Master Builder,” provides detailed 
information and instructions for installing Sage Master Builder software 
in different environments. 

Chapter 4, “Managing Your License with the License Administration 
Tool,” provides detailed information about:

• Setting the administrator password

• Managing and activating your license
7
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• Creating group reservations

• Using the License Administration Tool. 

Chapter 5, “License Use and Sage Master Builder,” provides all the 
necessary details about how the Sage license server manages your 
license attributes and how they are distributed to other computers 
running Sage Master Builder on your network. This information covers 
the concept of “license uses” in Sage Master Builder. 

“Appendix A: Special Configuration” contains information about 
configuring specific operating systems and network environments. Are 
you working in a Terminal Services environment? You will find that 
information about installing and running Terminal Services in this 
appendix. 

“Appendix B: Sage Master Builder API” contains overview information 
about running the Sage Master Builder API and working with third-party 
applications to extend Sage Master Builder’s capabilities. If you are a 
API software developer, then this chapter contains valuable information 
for you. 

“Appendix C: Sage Master Builder Enterprise Edition Installation” 
contains detailed installation instructions for the Enterprise Edition of 
Sage Master Builder.

The “Glossary” provides definitions of commonly used terms that you 
will encounter as you install and run Sage Master Builder software. Do 
you need to know what a “server” is? You will find the definition in the 
Glossary.

Printed and Printable Documentation

Sage Master Builder Release Notes

The Release Notes document provides information about enhancements 
and previously reported issues in the software that have been resolved for 
the current release. 

It also provides, where applicable, information and comments about 
recently discovered issues that have not yet been resolved before the 
latest software release. Release Notes are available in PDF format by 
8
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clicking Help > Printable Documentation > Release Note on the main 
Sage Master Builder window. 

Sage Master Builder User Guide

The Sage Master Builder User Guide is a printable-PDF version of the 
Sage Master Builder Help. You will find that the Sage Master Builder 
User Guide is the most comprehensive yet. It provides extensive 
explanation of Sage Master Builder functions and tools as well as 
hundreds of procedures for completing tasks.

Click Help > Printed Documentation on the main Sage Master Builder 
window to see a list of printable documentation. Then click a document 
to open it with Adobe Reader.

Getting Started: Sage Master Builder and Your Business

Getting Started: Sage Master Builder and Your Business provides basic 
information about key relationships in your business and how they inter-
act with Sage Master Builder. This book also explores the Sage Master 
Builder’s underlying concepts for working with general ledger, accounts 
payable, accounts receivable, and more. In addition, you will find 
detailed information about Sage Master Builder general operational fea-
tures, accounting, analysis, payroll, accounts receivable, accounts pay-
able, and more. If you are new to Sage Master Builder, we highly 
recommend that you read this book. 

Click Help > Printed Documentation on the main Sage Master Builder 
window to see a list of printable documentation. Then click a document 
to open it with Adobe Reader.

Getting Started: Product Overview

Getting Started: Product Overview provides background information to 
help you understand the core functionality of Sage Master Builder and 
how to use it to manage your business. If you are new to Sage Master 
Builder, then we highly recommend that you read the specific 
background information about the tasks that you will perform. If you are 

Note: 

The Sage Master Builder User Guide is a printable .pdf file 
of the in-product Help. 
9



Chapter 1
a company owner or administrator, we recommend that you read all the 
information in this guide. 

Click Help > Printed Documentation on the main Sage Master Builder 
window to see a list of printable documentation. Then click a document 
to open it with Adobe Reader.

Sage Master Builder SDK Developer Guide

The Sage Master Builder SDK Developer Guide provides information 
about the installation and setup of the Sage Master Builder API. It is a 
development tool for programmers who are working with other software 
products to build Sage Master Builder extensions. This guide is available 
as a .pdf file only. 

The Sage Master Builder SDK Developer Guide is available through the 
Developer Network Program. For information, browse to this link: 
http://www.sagemasterbuilder.com/services/s_a_mbdn.asp 

To view the product developed for Sage Master Builder using the API, 
browse to this link:
http://www.sagemasterbuilder.com/products/p_a_overview.asp 

Sage Master Builder API Object Reference Guide

The Sage Master Builder API Object Reference Guide provides detailed 
information about the mbXML tags for each supported Sage Master 
Builder object and a reference section for the mbXML Schema. For 
information about the purpose and functionality of the Sage Master 
Builder API, please refer to the Sage Master Builder SDK Developer 
Guide. 

The Sage Master Builder SDK Developer Guide is available through the 
Developer Network Program. For information, browse to this link: 
http://www.sagemasterbuilder.com/services/s_a_mbdn.asp

Printing Sage Master Builder printable documentation

Links to the printable documentation are located under Help > Printable 
Documentation menu on the Sage Master Builder main window. 
10
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To print a Sage Master Builder printable document: 

1. Click Help > Printable Documentation.

2. From the menu list, select the printable document you want to open.

Adobe Reader opens and loads the guide.

3. From the File menu, click Print.

Customer Support Resources

Contacting Customer Support

For more information about locating the product keys to activate your 
Sage Master Builder license, refer to the Sage Master Builder 
Installation QuickStart Guide or the Sage Master Builder Installation 
and License Administration Guide. If you need further assistance with 
installation, product keys, or license activation, call Customer Support at 
800-866-8049.

If you have questions about Sage Master Builder, please refer to the in-
product Help by pressing the F1 key in a specific window or by 
accessing Help through the drop-down list in the menu bar. If you require 
assistance and have a current support contract, contact Customer Support 
at 800-866-8049. There is also additional Customer Support contact 
information on our Web site:
http://sagemasterbuilder.com/customer_care/techsupport.asp 

Frequently Asked Questions

With a customer support contract, you have access via the Internet to 
Frequently Asked Questions (FAQ) Knowledgebase. This resource 
contains a wealth of technical information, including top FAQs by 

Important: 

You must have the Adobe® Reader® installed on your 
computer to view and print Sage Master Builder guides. To 
download this free software for viewing and printing 
documents in PDF format, visit
http://www.adobe.com/products/acrobat/readstep2.html 
11
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product version, common “How Do I” articles, as well as procedures for 
troubleshooting error messages or other problems. Best of all, it is 
updated continuously to bring you the hottest product alerts. 

You must have a User Name and password to access FAQs. Contact 
information is available at our web site:
http://sagemasterbuilder.com/customer_care/techsupport.asp 

About the Remote Assist Tool

The Remote Assist Tool allows Sage Customer Support representatives 
to access your systems and data remotely through your computer to 
provide support services to you and your company. You can quickly 
access the Remote Assist Tool from a Help menu link on the Sage Master 
Builder main page. Point to Help > Customer Resources > Technical 
Support > Remote Assist Tool.

Training Resources

Training options

Learning to use Sage Master Builder software has never been easier! 
Whether you choose to take online classes, work directly with your Sage 
Certified Consultant, or attend a seminar, you will learn how to get the 
most from Sage Master Builder. New and experienced users alike will 
discover new ways to save time and get more from every aspect of Sage 
Master Builder.

Overview of customer classes

Online classes make learning Sage Master Builder convenient and easy. 
Each instructor has years of experience using Sage Master Builder and 
will lead you step-by-step through the class material. 

Online classes allow you to view the instructor’s computer screen as he 
or she demonstrates Sage Master Builder software. To participate in a 
class, simply dial in to a toll-free number and log on to a web site. 
Because the classes are live, you can ask questions and benefit from 
other students’ questions. Classes cover all aspects of Sage Master 
Builder, including project management, estimating, scheduling, and pay-
roll. For more information, check our Frequently Asked Questions page: 
http://sagemasterbuilder.com/services/s_t_faq.asp 
12

http://sagemasterbuilder.com/customer_care/techsupport.asp
http://sagemasterbuilder.com/services/s_t_faq.asp


 Welcome to Sage Master Builder Installation
Getting started with training

All customers should begin with our New Customer Training series. 
These classes include an overview of the system features. They introduce 
you to Sage Master Builder and get you started. For more information, 
visit
http://sagemasterbuilder.com/customer_care/training.asp 

Business Partners and Sage Certified Consultants

About Business Partners and Sage Certified Consultants

To serve you better, Sage Master Builder products and services are 
available to you through an authorized network of more than 100 
business partners.

Your business partner has a team of certified consultants available to 
serve you. From simple how-to questions and hands-on demonstrations, 
to installation, implementation, and training, they're fully equipped to 
help you get where you want to be. For more information please contact 
your Sage Master Builder business partner.
13
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Chapter 2

System Requirements and 
Configuration
This chapter provides information about the following:

• Hardware Requirements

• Operating System Requirements

• Network Configuration Requirements

• Microsoft® .NET Framework® 2.0 Requirements

• Report Scheduling and Faxing Functionality

• Report Scheduling and Faxing Functionality

• Sage Master Builder API
15
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Hardware Requirements

About system requirements and configuration

It is very important to verify that your computers and server meet the 
system requirements for installing and running Sage Master Builder. We 
strongly recommend that you read through these system requirements 
before you begin installing any Sage Master Builder software.

About the Sage System Verification utility

The Sage System Verification utility is installed to the \MB7\Programs 
folder with each Sage Master Builder installation. This utility assists 
with trouble shooting the customers hardware related to the Sage 
licensing component.

Server hardware specifications

We cannot recommend server hardware specifications for your network 
as this depends on your specific requirements, such as the number of 
users on your network or other programs that might use server resources, 
such as firewalls, software applications, mail systems, and so forth. We 
can, however, recommend a set of minimum hardware requirements.

Data backup

With any computer system, there is the possibility for failure and loss of 
data. For more information about backing up data, refer to the Sage 
Master Builder Help. 

Caution!
We strongly recommend that an uninterruptible power 
system (UPS) be connected to the computer (workstation 
or server) in case of a power disruption in which you might 
lose data. The specifications for your UPS must be 
determined by your needs and level of risk.
16
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Server hardware requirements

Client and workstation hardware requirements

Caution!
Use a backup method and device suitable for your 
business requirements. We strongly recommend that you 
maintain a routine backup schedule and store your data in 
a safe environment that is separate from your server, 
preferably off site.

Server 
Hardware

Minimum Recommended

Processor Intel® Pentium® 
4 or comparable

Intel® Pentium® 4 or compara-
ble

RAM 1 GB 4 GB+

Free Disk 
Space

3.5 GB 3.5 GB+

CD-ROM Drive 2X CD-ROM 2X CD-ROM+

Printers For highest quality printing, we recommend laser or 
inkjet printers.

Important: 

These minimum recommendations include the 370 MB of 
hard disk drive space required for running Microsoft® .NET 
Framework® 2.0 software.

Related topics...

Minimum requirements for the .NET Framework on servers

Minimum requirements for the .NET Framework on clients

Client and workstation hardware
17
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Hardware Minimum Recommended

Processor 
(except Vista)

Pentium 3 or compara-
ble

Pentium 4 or comparable

Vista worksta-
tion processor

1 GHz 32-bit 1 GHz+ 32-bit

RAM (except 
Vista)

512 MB 1 GB+

Vista worksta-
tion RAM

1 GB 2 GB

Free Disk 
Space

1 GB 3 GB+

CD-ROM Drive 2X CD-ROM 2X CD-ROM+

Printers For highest quality printing, we recommend laser or 
inkjet printers.

Note: 

• These minimum recommendations include the 230 MB 
required for running Microsoft .NET Framework 2.0 
software. 

• The recommended free disk space is based on the 
installation of a single program and the average size of 
a Sage Master Builder company database. Allow at 
least 50 MB for each additional company database 
that you create.

Related topics...

Minimum requirements for the .NET Framework on servers

Minimum requirements for the .NET Framework on clients

Server hardware requirements
18
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Operating System Requirements

Operating systems

We recommend that the following issues be taken into account for a 
smooth and successful installation experience:

Caution!
Sage Master Builder and/or its components do not run on 
or are not supported by some operating systems. Do not 
install Sage Master Builder to computers running these 
operating systems: 
• Windows 95
• Windows 98
• Windows NT Server
• Windows NT Workstation
• Any 64-bit operating systems

Important:

• Microsoft .NET framework, version 2.0 must be 
installed on all computers running Sage Master Builder 
and the License Administration Tool. 

• During installation, the .NET Framework 2.0 is installed 
on your computer automatically if it is not already 
installed.

• Be sure that all server and client computers meet both 
.NET requirements and Sage Master Builder 
requirements.
19
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Web browser requirements

Network Configuration Requirements

Server network configuration

Server Client/Workstation

Microsoft® Windows® 

Server 2003®

Microsoft Windows Small 

Business Server 2003® 

(SP 1 or newer)

Microsoft Windows 2000 

Server® (SP 4 or newer)

Microsoft Windows Vista® 

Business

Microsoft Windows XP® 
Professional (SP 2 or newer)

Microsoft Windows 2000® 
Professional (SP 4 or newer)

Note: 

When you have a network with three or more users, a dedi-
cated file server increases performance and reliability.

Minimum Recommended

Microsoft® Internet 

Explorer® 6.0, Service Pack 
1

Microsoft® Internet 

Explorer® 6.0, Service Pack 
1

Note: 

• Sage Master Builder, Enterprise Edition runs in a wide 
area network (WAN) environment. 

• For information about running Sage Master Builder in 
a WAN, contact your Business Partner or Sage 
Certified Consultant. 
20
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Client and workstation network configuration

Microsoft .NET Framework 2.0 Requirements

About installation and Microsoft .NET Framework

When you install Sage Master Builder software, you will also install the 
Microsoft .NET Framework 2.0, if it is not already installed. It is 
important that you make sure that both your client and server computers 
meet the minimum requirements for installing both Sage Master Builder 
software and the .NET Framework 2.0. 

Process Required

Network Protocol TCP/IP

Minimum 
Network Speed - 
LAN

10/100/1000 Mbps

Minimum 
Network Speed - 
WAN

+/- 1.5 Mbps receiving data 
(downstream)
+/- 384 Kbps sending data 
(upstream)

Note: 

For information about running Sage Master Builder in a 
wide area network (WAN), contact your Business Partner 
or Sage Certified Consultant. 

Process Required

Network Protocol TCP/IP

Minimum Network Speed 
- LAN

10/100/1000 Mbps

Minimum Network Speed 
- WAN

128 Kbps Broadband
21
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About installing .NET Framework 2.0 and Operating Systems

The following are the supported operating systems for .NET Framework 
2.0:

• Microsoft Windows 2000 Professional with SP4

• Windows 2000 Server with SP4

• Windows 2000 Advanced Server with SP4

• Windows 2000 Datacenter Server with SP4 

• Microsoft Windows XP Professional with SP1 or newer

• Windows XP Home Edition with SP1 or newer

Important: 

If the Sage Master Builder installation requires an 
installation of Microsoft .NET Framework 2.0, the Sage 
Master Builder installation process may continue 
automatically after the .NET Framework installation is 
completed. If you are prompted to restart your computer 
after the .NET Framework installation, however, you must 
do it to continue the Sage Master Builder installation. 

Caution!
The .NET Framework cannot be installed on the following 
operating systems: 
• Microsoft Windows 95
• Microsoft Windows NT Server
• Microsoft NT Workstation
• Windows Server 2003, Enterprise Edition for Itanium-

based Systems
• Windows Server 2003, Datacenter Edition for Itanium-

based Systems

Note: 

If Microsoft .NET Framework 2.0 is not already installed on 
your computers, then that installation alone may take up to 
20 minutes per computer.
22
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• Microsoft Windows Server 2003 Standard Edition 

• Windows Server 2003 Enterprise Edition 

Viewing and verifying system information

You may use the Winmsd.exe to open the System Information 
window to view a list of your system information. 

To view and verify system information: 

1. Click Start, then click Run. 

The Run dialog box opens.

2. In the Open text box, type winmsd.exe, and then press the 
ENTER key. 

The System Information window opens displaying a list of your 
system information.

.NET Framework Requirements for Server Computers

Minimum requirements for the .NET Framework 2.0 on servers

Component Required

Hard disk space at installation 800 MB

Hard disk space to run 370 MB

Video card 800x600, 256 colors

Related topics...

Server hardware requirements

Client and workstation hardware

Minimum requirements for the .NET Framework on clients
23
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Verifying that Windows 2000 Service Pack 4 is installed

 To verify that Service Pack 4 is installed: 

1. Right-click Start, and then click Explore. 

2. Right-click My Computer, and then click Properties. 

The System Properties dialog box appears and displays the service 
pack level of the system on the General tab. 

.NET Framework Requirements for Client Computers

Minimum requirements for the .NET Framework 2.0 on clients

Important: 

Before you install the .NET Framework 2.0 on a Windows 
2000-based computer, you must have Windows 2000 
Service Pack 4 installed.

Note: 

To download service packs for Windows 2000, visit the 
following Microsoft Web site:
http://www.microsoft.com/windows2000/downloads/
servicepacks/default.asp 

Component Required

Hard disk space at installation 160 MB

Hard disk space to run 70 MB

Video card 800x600, 256 colors

Related topics...

Server hardware requirements

Client and workstation hardware

Minimum requirements for the .NET Framework on servers
24
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Verifying that Microsoft Internet Explorer 6.0 Service Pack 1 
is installed

You need to have Microsoft Internet Explorer 6.0 Service Pack 1 
installed on a client to meet minimum requirements for running Sage 
Master Builder software. This is also a requirement for installing and 
running .NET Framework 2.0. 

To verify that Microsoft Internet Explorer 6.0 Service Pack 1 is 
installed: 

1. Launch Internet Explorer.

2. On the Internet Explorer Help menu, click About. 

3. In the About Internet Explorer dialog box, verify that the version 
number is 6.0 Service Pack 1 or newer, and then click OK. 

Verifying that Microsoft Windows Installer 3.1 is installed

Sage Master Builder and the License Administration Tool require .NET 
Framework 2.0 to run. The .NET Framework 2.0 requires the Windows 
Installer 3.1 to be installed. When you install Sage Master Builder 
software, you will also install the Windows Installer 3.1 automatically, if 
it isn’t already installed. Many newer operating systems are integrated 
with Windows Installer 3.1 already. 

To verify that Microsoft Windows Installer 3.1 is installed on 
earlier operating systems:

1. Click Start, and then click Run. 

2. In the Open text box, type msiexec /?, and then press ENTER or 
click OK. 

3. In the Windows Installer dialog box, verify that the version number 
is 3.1, and then click OK. 

Note: 

To download Service Pack 1 for of Microsoft Internet 
Explorer 6.0, visit the following Microsoft Web site: 
http://www.microsoft.com/windows/ie/ie6/downloads/
critical/ie6sp1/default.mspx 
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Verifying that Windows Management Instrumentation (WMI) 
is installed

When you plan to install .NET Framework applications that access 
system management information, you must install Windows 
Management Instrumentation (WMI). This component is installed as part 
of the core operating system on Windows XP and Windows 2000. 

To verify that WMI is installed: 

• Confirm that you have the %SystemRoot%\System32\WBEM\ 
folder.

Report Scheduling and Faxing Functionality

About setting up emailing and faxing through Sage Master 
Builder

Important information regarding Report Scheduling and 
Faxing Functionality 

Using the faxing functionality through the Sage Master Builder program 
requires a separate installation and setup procedure for a fax modem in 
your workstation and access to an analog phone line. You may also have 
to set up the cover page information and the number of times that the fax 
re-tries to send. 

Note: 

• To download the latest version of the WMI, visit the 
following Microsoft Web site:
http://msdn2.microsoft.com/en-us/library/
aa394582.aspx

• Before you install the .NET Framework 2.0 on a 
Windows 2000-based client computer, make sure that 
you have installed Windows 2000 Service Pack 4 or 
newer. To determine whether Service Pack 4 or newer 
is installed, see the topic, “Verifying that Windows 
2000 Service Pack 4 is installed” in the subsection, 
.NET Requirements for Server Computers.
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 System Requirements and Configuration
For more information about installing and setting up your fax modem, 
refer to the documentation that came with your fax modem. Sage Master 
Builder does not provide support for installing or setting up a fax 
modem.

Faxing Functionality and Operating Systems

Faxing functionality through Sage Master Builder only works with 
Windows 2000 Professional, Windows XP Professional, Windows 
Server 2003, and Vista Business operating systems. Faxing functionality 
requires that a version of Adobe Reader is installed on the computer 
doing the faxing. 

Adobe Reader Version 8 not supported for faxing

Adobe Reader Version 8 does not support faxing from Windows. 
Therefore, you cannot fax from Sage Master Builder using Adobe 
Reader 8. Possible resolution is:

• Uninstall Reader Version 8, and install Reader Version 7. For 
instructions about downloading and installing Adobe Reader Version 
7, search the Internet with your favorite search engine for Adobe 
Reader Version 7 downloads. Note: As of the pre-release date, if you 
select Vista as your operating system on the Adobe site, the default is 
to the download Reader Version 8.1; however, if you select the XP 
operating system, you have the option to download Reader Version 
7. 

Adobe Reader Version 7 remains visible in system tray

When faxing from Sage Master Builder using the Vista operating system, 
the Reader icon remains visible in your system tray instead of closing. 
The Reader window can be closed manually, and nothing prevents the 
fax from being sent.

Adobe Reader Version 7 displays error message on Window 
2000 

When faxing from Sage Master Builder using the Windows 2000 
operating system, Adobe Reader Version 7 stays visible on task bar, and 
it displays an error message. The Reader window can be closed 
manually, and the message does not prevent the fax from being sent. 
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If you prefer not to see this message, uninstall Adobe Reader Version 7, 
and install Adobe Reader Version 6. For instructions about downloading 
and installing Adobe Reader Version 6, search the Internet with your 
favorite search engine for Adobe Reader Version 6 downloads.

Faxing and Adobe Reader version recommendations

Faxing through Sage Master Builder uses the Adobe Reader program. 
Some versions of Adobe Reader work better with specific operating 
systems. We recommend the following guidelines: 

• When running Microsoft Windows 2000, use Acrobat 6. 

• When running Microsoft Windows XP, use Acrobat 6 or 7. 

• When running Microsoft Vista, use Acrobat 7

Adobe Reader and Automatic Updates

On the workstation(s) sending faxes, you must have Adobe Reader 
(version 5 or higher) installed. It is likely that you already have this free 
program installed if you have used the PDF copies of our manuals or 
some of our training class materials. If not, you can go to Adobe's web 
site to download it:
http://www.adobe.com/products/acrobat/readstep2.html 

Disengage automatic updating for Adobe Reader

If you are using the scheduling capability for sending faxes, we 
recommend that you disengage the automatic “check for updates” 
capability of Acrobat Reader as it will prevent scheduled reports from 
completing.

Note: 

Instructions disengaging automatic “check for updates” 
differ from version to version of Adobe Reader. Refer to the 
Adobe Reader Help for instructions. 
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Report Scheduling and Email Functionality 

Using the ISP’s simple mail transfer protocol (SMTP) server to send 
email via Sage Master Builder typically requires “user authentication” at 
the STMP server. An example of an SMTP email server name is 
“smtp.att.sbcglobal.net.”

Different ISPs may use different terms when referring to user 
authentication. In general, however, user authentication means verifying 
a user’s identity by means of a “user name” and “password.” 

In the context of sending email through Sage Master Builder using an 
ISP’s SMTP server, user authentication only refers to verifying the user’s 
identity at the ISP’s SMTP server. It does not refer to your: 

• Sage Master Builder user name and password

• Network domain user name and password

• Windows system user name and password. 

Important: 

Using the email capability of Sage Master Builder requires 
access to a simple mail transfer protocol (SMTP) email 
server. This server may be located on your workstation PC, 
on a server on your company’s network, or at your Internet 
service provider (ISP). If the email server is local, you may 
need the assistance of an IT professional to properly 
identify or set up this capability. If the email server is 
located at your ISP, you may need contact your ISP for 
assistance. 

Note:

• Sage Software does not provide support for setting up 
or installing an email server.

• You set up user authentication and your fax line access 
dial out number on 7-2 Company Information. Click 
this Help topic “Entering company information.
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Sage Master Builder API

System requirements for Sage Master Builder API

If you are using the Sage Master Builder API, the minimum and 
recommended system requirements may vary. These requirements must 
be considered in addition to the recommended system requirements for 
running Sage Master Builder or the Sage Master Builder Enterprise 
Edition. 

It may be necessary to increase the processor speed, memory and/or disk 
space of your system depending upon the requirements of the third-party 
application using the API. Please consult with your third-party vendor to 
determine what changes, if any, should be made to your hardware 
configuration in order to meet your desired performance criteria.
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Sage Master Builder Installation
This chapter provides information about the following:

• Installation Preview

• Program Installation to Different Configurations

• New Installations

• Upgrade Installations
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Installation Preview

Business implementation considerations and installation

Installing Sage Master Builder software should be very easy to complete; 
however, implementing and running your business in Sage Master 
Builder must be thoroughly planned out in advance to harness the 
tremendous power of this software. 

We recommend that you take full advantage of all the knowledge and 
advice found in Sage Master Builder documentation and training classes. 
We also recommend that you work with Sage Certified Consultants, 
Business Partners, and accounting professionals before you begin to 
implement this software for your business. 

Pre-installation information

Important: 

If this is a first-time installation of Sage Master Builder, 
working in the program with your company data must be 
preceded by a data migration and business implementation 
plan. For more information about implementing Sage 
Master Builder for your company, see the information in 
Chapter 1 of this guide about Business Partners and Sage 
Certified Consultants. 

Related topics...

Pre-installation information

Recommended installation locations

Installing to different network environments

Caution!
For current Sage Master Builders customers: When you 
reinstall or upgrade, turn off scheduled reports. Reports 
must not be printed, faxed, or emailed at the same time as 
your reinstall or upgrade. 
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Duration of the installation process

Plan on at least 5 and possibly up to 20 minutes per computer to install 
Sage Master Builder and its companion software, such as the Sample 
Company and the License Administration Tool. The duration of the Sage 
Master Builder installation depends a great deal upon each computer’s 
configuration. For example, some newer computers are pre-installed 
with essential software required to run Sage Master Builder software 
such as the .NET Framework and the Windows Installer 3.1. Installation 
to some older computer may take more time.

Other required software

Both Windows Installer 3.1 and the Microsoft .NET Framework 2.0 must 
be installed on all computers running Sage Master Builder software. 

Caution!
For current Sage Master Builder customers: Do not 
upgrade or reinstall Sage Master Builder while the Sage 
Master Builder API is running.

Important: 

• Existing Sage Master Builder customers: Before you 
install, make a backup copy of your existing company 
data. 

• Before installing Sage Master Builder software, shut 
down all other programs except firewall or antivirus 
software. 

• You must have administrator rights on the network and 
administrator rights on each computer to install Sage 
Master Builder software. Administrators have full 
control over computers for installing software. 

• We strongly recommend that you install the Sage 
license server on a computer that is always available 
to other computers on your network that are running 
Sage Master Builder.

• For installation on Citrix and Terminal Servers, see 
Appendix A, Special Configuration under the section, 
Citrix and Terminal Servers.”
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First, the installer determines if the .NET Framework 2.0 and the 
Windows Installer 3.1 are already installed. If not, the installer installs 
the required software automatically. 

Plan for an additional 10 to 15 minutes per computer to install .NET 
Framework 2.0 and Windows Installer 3.1 on each computer. 

Product CD

You need the product CD to install the Sage Master Builder software.

Installation and Internet connectivity

Internet access is not required when you install Sage Master Builder.

Installation environments, operating systems, and services

It is very important that you understand the network environments and 
operating systems on the computers and server computers where you 
install Sage Master Builder software. Appendix A, Special Configuration 
provides detailed information about installing to different environments. 

Installation options

When you load the Sage Master Builder CD into your CD drive, the 
Welcome to Sage Master Builder Installation window opens. You are 
presented with two options. 

• This computer will be my Sage license server. Choose this option 
to install the Sage license server on the computer that is your 
network server. You only need to install this option one time on your 
network. This is the computer on which you activate your license.

Important: 

If you need to install Windows Installer 3.1, then the 
computer must restart before you continue with the Sage 
Master Builder installation. After your computer restarts, 
opening and closing your CD drawer with the installation CD 
in it should restart the Sage Master Builder installation. If 
the install program does not start automatically, go to 
Start > Run > Browse, locate your CD drive and select 
SageMasterBuilder.exe. Then click OK. 
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• This computer will run Sage Master Builder only. You may install 
Sage Master Builder on as many computers as you like. Following 
each Sage Master Builder installation, you must specify the 
computer on your network that is the Sage license server.

Recommended installation locations

We recommend that you install the Sage license server program and 
activate your license where your Sage Master Builder company database 
is or will be located. You should have addressed security and stability 
issues on this computer already. Locating the Sage license server on the 
same computer with the company data decreases troubleshooting time in 
the event of a network connectivity problem or hardware failure. 

We recommend that an uninterruptible power system (UPS) be 
connected to your network server computer in case of a power 
disruption. This helps prevent data loss and also decreases 
troubleshooting time in the event of a network connectivity problem or 
hardware failure. The specifications for your UPS must be determined by 
your needs and level of risk.

Related topics...

Installing the Sample Company

About Sage Master Builder API

Installing Sage Master Builder programs on Citrix and 
Terminal Servers

Glossary definitions
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To run Sage Master Builder connected to your company data, computers 
must be connected to the Sage license sever. If a person has a 
connectivity problem or license use problem and sees the an unable to 
connect message when all other people are connected, then you know 
that the connectivity problem is limited to that one person. If you 
encounter a hardware failure with your server, then all the people 
running Sage Master Builder will be disconnected. 

The License Administration Tool program is installed on all computers 
by design. The License Administration Tool’s Administrator can log on 
to the tool from any computer on the network to manage license issues. 
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This provides more access possibilities for the Administrator to manage 
license and reservation functions. 

Other Installations Options and Considerations

About installation and third-party firewalls

There are many third-party firewalls on the market, such as those 
manufactured by Norton, MacAfee, and Zone Labs. You may have one 
of these firewalls installed on your network computers. If that is the case, 
the firewall is going to display an alert message when you install any 
new program that acts as a server or accesses the Internet. When 
installing Sage Master Builder, Sage license server, the Sage Master 
Builder API, Microsoft .NET Framework 2.0, and/or any other new 
application on your computer, you will see firewall alerts. 

When you see the alert messages asking if you should allow any of these 
services and programs related to Sage Software products and Sage 
Master Builder to access the Internet, choose to allow them to access the 
Internet and/or run as a service.

Installing the Sample Company

The Sample Company is pre-selected to install with Sage Master 
Builder software. It provides an example of running a company in Sage 
Master Builder. There are sample accounts, sample employees, sample 
takeoffs, and much more. By viewing and working with this sample data, 
you can gain an understanding of how Sage Master Builder helps you 
manage your construction business. 

In addition, Sage Master Builder trainers use the Sample Company 
extensively during Sage Master Builder training classes. We highly 
recommend that you install the Sample Company during initial 
installation and that you re-installing when upgrading. 

Related topics...

Installing the Sage License Server
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Installing the Sage Master Builder API

The Sage Master Builder API is installed by default on all computers. It 
allows software developers to create applications with features more 
precisely targeted for highly specific market segments while at the same 
time leveraging the substantial functionality already provided by Sage 
Master Builder. 

For example, a project estimating application could be developed to 
integrate with Sage Master Builder to take advantage of Sage Master 
Builder’s powerful accounting and project management features. For 
more information about the Sage Master Builder API, seeAppendix B: 
Sage Master Builder API. 

Program Installation to Different Configurations

About installing the Sage Master Builder software to different 
configurations

You can install Sage Master Builder software to many different 
configurations, for example, stand-alone, network server, Citrix and 
Terminal Services servers, peer-to-peer servers, and workstations.

Important: 

Installing the Sample Company overwrites any previous 
installations of the Sample Company. 

Important: 

• The optimal operational size of a peer-to-peer network 
running Sage Master Builder is two to five 
workstations. Additional workstations may adversely 
impact Sage Master Builder response times. Networks 
consisting of more than five (5) workstations may need 
to use one computer as a dedicated server.

• For installation to Citrix and Terminal Servers, see 
Appendix A, Special Configuration under the section, 
Citrix and Terminal Servers.”
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Sage Master Builder allows users to share data and reports stored on a 
network hard drive. From different workstations, users can then access 
the server to share one set of data, one set of reports, and one set of report 
forms.

The installation program checks for the components necessary to run 
Sage Master Builder and then copies the program modules and reports to 
the \MB7 folder and subfolders that are created on the hard disk. In 
addition, the installation copies system files necessary for program 
operations to the Windows and Windows System folders.

The installation process does not make any configuration changes to the 
computer. After installation is complete, you must configure the stand-
alone computer, server computer, or workstation for optimal 
performance. For example, you need to configure the date format on 
computers running the Windows Server 2003 operating system. For 
detailed information about configuring each server and workstation 
depending on its operating system, see Appendix A, Special 
Configuration.

Note: 

When you receive program updates, repeat the installation 
to each workstation or server where the Sage Master 
Builder program is installed.

Related topics...

About installation and third-party firewalls

Installing on computers running Citrix and Terminal Servers 
using DOS commands
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New Installations

Installing the Sage license server 

When you begin the installation process from the CD-ROM, you are 
presented with two installation options:

• This computer will be my Sage license server.

• This computer will run Sage Master Builder only.

To install to the Sage license server:

1. Insert the Sage Master Builder CD into your CD-ROM drive. 

If the install program does not start automatically, go to Start > Run 
> Browse, locate your CD drive and select SageMasterBuilder.exe. 
Then click OK. 

2. On the installation window, read the instructions on the installation 
welcome window, and click Next. 

Important: 

• This step-by-step procedure is for new installations 
only: (1) Sage Master Builder has never been installed 
on the computer, or (2) The Sage Master Builder 
program, Sage Master Builder licensing, and Sage 
Master Builder API have all been uninstalled using Add 
and Remove Programs. 

• This suggested flow of installation procedures is for 
Sage Master Builder only and not for Sage Master 
Builder Enterprise Edition. For Sage Master Builder 
Enterprise Installation and configuration procedures, 
see “Appendix C” in this book.

Note: 

Also select this option if you are running in a stand-alone 
environment. Stand-alone means that you are running Sage 
Master Builder on one computer, or you are not networking 
with other computers running Sage Master Builder.
40



 Sage Master Builder Installation
3. On the installation option window, select the option This computer 
will be my Sage license server, and click Next. 

4. On license agreement window, read the License Agreement 
carefully. 

5. Select the check box to accept the terms, then click Next to continue 
the installation. 

The select a drive window appears. The check box for installing the 
Sample Company is pre-selected. We recommend installing the 
Sample Company on all computers.

6. Select a local drive location for the installation, and click Next.

The installer begins the installation process. It checks to see if the 
computer has .NET Framework 2.0 and Windows Installer 3.1 
installed. If these programs are not found, the installer installs them. 

The Sage Master Builder API is installed next. For more information 
about the Sage Master Builder API, see Appendix B: Sage Master 
Builder API.

At the end of the installation process, a confirmation window 
appears containing a list of installed programs. Here is an example.

Important: 

Sage Master Builder should always be installed to a local 
drive. You can share Master Builder data that is located on 
a network drive among client workstations running Sage 
Master Builder locally.

Note: 

If you need to install Windows Installer 3.1, then the 
computer must restart before you continue with the Sage 
Master Builder installation. After your computer restarts, 
opening and closing your CD drawer with the installation CD 
in it should restart the Sage Master Builder installation. If 
the install program does not start automatically, go to 
Start > Run > Browse, locate your CD drive and select 
SageMasterBuilder.exe. Then click OK. 
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• Sage license server software

• License Administration Tool

• Sage Master Builder

• Sample Company

This window also displays the computer’s IP Address and its 
network name. You will use this information to specify the Sage 
license server.

7. Review the list of installed programs, and write down the IP Address 
and network name of the computer.

8. Click Next. 

The activate your product license window appears. The Launch the 
License Administration Tool check box is pre-selected to launch 
the License Administration Tool so you can activate your license.

9. Read the instructions about activating your product license, and then 
click Finish. 

10. The Logon Administrator Password window opens. 

11. Set the Administrator password. 

For information about this process, click the Help button on the 
Logon Administrator Password window. 

For details about managing your license, see Chapter 4, Managing 
Your License with the License Administration Tool.

Important: 

Keep the Sage license server computer’s IP Address and 
name in a convenient location. To select the Sage license 
server from client computers running Sage Master Builder, 
you need to select its name from a list or type the 
computer’s IP Address or name in a text box.
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Installing Sage Master Builder

When you begin the installation process from the CD-ROM, you are 
presented with two installation options:

• This computer will be my Sage license server.

• This computer will run Sage Master Builder only.

To install Sage Master Builder only: 

1. Insert the Sage Master Builder CD into your CD-ROM drive. 

If the install program does not start automatically, go to Start > Run 
> Browse, locate your CD drive and select SageMasterBuilder.exe. 
Then click OK. 

2. On the installation welcome window, read the instructions on the 
installation welcome window, and click Next. 

3. On the installation option window, select the option This computer 
will run Sage Master Builder only, and click Next. 

4. On the license agreement window, read the License Agreement 
carefully. 

5. Select the check box to accept the terms, then click Next to continue 
the installation. 

Important: 

• This step-by-step procedure is for new installations 
only: (1) Sage Master Builder has never been installed 
on the computer, or (2) The Sage Master Builder 
program, Sage Master Builder licensing, and Sage 
Master Builder API have all been uninstalled using Add 
and Remove Programs. 

• This suggested flow of installation procedures is for 
Sage Master Builder only and not for Sage Master 
Builder Enterprise Edition. For Sage Master Builder 
Enterprise Installation and configuration procedures, 
see “Appendix C” in this book.
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The select a drive window appears. The check box for installing the 
Sample Company is pre-selected. We recommend installing the 
Sample Company on all computers for training purposes.

6. Select a local drive location for the installation, and click Next.

The installer begins the installation process. It checks to see if the 
computer has .NET Framework 2.0 and Windows Installer 3.1 
installed. If these programs are not found, the installer installs them. 

The Sage Master Builder API is installed next. For more information 
about the Sage Master Builder API, see Appendix B: Sage Master 
Builder API.

An installation complete window appears. The Launch Sage 
Master Builder check box is pre-selected so that you can launch 
Sage Master Builder and specify the Sage license server. 

7. Read the important message and follow the instructions to launch 
Sage Master Builder. 

8. Click Finish. 

Master Builder begins its launch process by displaying the Specify 
Sage License Server window. 

For more information about this process, you can click the Help 
button on the Specify Sage License Server, or see Chapter 5, 
License Use and Sage Master Builder.

Note: 

If you need to install Windows Installer 3.1, then the 
computer must restart before you continue with the Sage 
Master Builder installation. After your computer restarts, 
opening and closing your CD drawer with the installation CD 
in it should restart the Sage Master Builder installation. If 
the install program does not start automatically, go to 
Start > Run > Browse, locate your CD drive and select 
SageMasterBuilder.exe. Then click OK. 

Related topics...

About upgrading Sage Master Builder
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Upgrade Installations

About upgrading Sage Master Builder

If you are an existing Sage Master Builder customer, installing the next 
version on computers that already have Sage Master Builder installed 
“upgrades” the software. This version of Sage Master Builder upgrades 
the software from version 12 to version 13. This upgrade will also update 
your Sage licensing software automatically. 

When you upgrade Sage Master Builder, the program recognizes what 
configuration has been previously installed on each computer. For 
example, when you upgrade the license server computer, the program 
recognizes that this computer is your license server and upgrades it 
accordingly. Similarly, when you upgrade a workstation computer, the 
program upgrades that computer as a workstation.

Upgrade pre-installation tasks

Upgrading your Sage Master Builder software requires that you 
complete preliminary tasks to ensure the safety of your company data in 
Sage Master Builder. Additional tasks may be completed using Microsoft 
Windows functions or third-party program functions. Information on 
completing these tasks is located in the Sage Master Builder program 
Help. 

When upgrading from version 12 to version 13, it is important that you 
choose a block of time when you can install the upgrade to all the 
computers in your office beginning with your Sage license server 
computer. Depending on your computer’s hardware and your network 

Important: 

If the Sage licensing software version does not match 
between the workstation computer and the license server 
computer, then Sage Master Builder will not run on the 
client. To prevent this from happening, make sure that the 
license server computer and all client workstation 
computers are running the same version of the Sage 
licensing software. When upgrading, you should install the 
upgrade to the license server computer first. 
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configuration, plan on 15 to 30 minutes per computer for the installation 
process alone. Additional tasks may take extra time. 

1. Make two backups of your company data - For instructions, 
launch the Sage Master Builder Help viewer and search using the 
Help search shortcut “databackup” to find the data backup topics. 

2. Make sure that no reports are scheduled to run during 
installation - Plan your upgrade installation during the time when no 
reports are scheduled to be printed, faxed or emailed. For 
instructions, launch the Sage Master Builder Help viewer and search 
using the Help search shortcut “schedulereports.” More topics about 
scheduling reports are located at the end of the topic “About report 
scheduling.” 

3. Exit Sage Master Builder and all other programs - You cannot 
install the Sage Master Builder upgrade when the program is 
running. We recommend that you shut down all programs when 
installing Sage Master Builder. 

4. Locate the Sage license server on your network, and begin the 
upgrade installation there. 

Installing the upgrade to either the Sage license server or 
client workstation

Use the same upgrade installation process for both your Sage license 
server computer and your workstation computers.

Note: 

You do not have to shut down your antivirus or firewall 
programs to install Sage Master Builder. 

Related topics...

About upgrading Sage Master Builder
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To install the upgrade:

1. Insert the Sage Master Builder CD into your CD-ROM drive. 

If the install program does not start automatically, go to Start > Run 
> Browse, locate your CD drive and select SageMasterBuilder.exe. 
Then click OK. 

2. On the Welcome window, notice that a previous installation has been 
found, and click Next. 

3. On license agreement window, read the License Agreement 
carefully. 

4. Select the check box to accept the terms, then click Next.

5. On the Select a drive window, select the local drive where Sage 
Master Builder is currently installed. 

The check box for installing the Sample Company is pre-selected. 
We recommend that you install the Sample Company on all 
computers for training purposes.

6. To begin the installation, click Next.

The installation process installs Sage Master Builder, Sage licensing 
software, and the API program. When the installation is finished, the 
Launch Sage Master Builder check box is pre-selected so that you 
can launch Sage Master Builder. 

Important: 

Begin installing the upgrade first on the existing Sage 
license server computer, and then install it to the 
workstations once the license server installation is 
complete. 

Important:

The upgrade installation over-writes the existing Sample 
Company. If you want to save changes to the existing 
Sample Company, clear the check box. If you do not over-
write the Sample Company, you must reindex the Sample 
Company database using 7-4 Rebuild Indexes after the 
upgrade installation. 
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7. On the Installation complete window, click Finish to launch Sage 
Master Builder. 

8. Follow the instructions for Post installation tasks to re-index your 
company database from one computer and re-schedule your reports, 
as necessary. 

Upgrade post-installation tasks

Once you have completed your upgrade installation, complete the 
following tasks before you open your company and begin work in 
Version 13 of Sage Master Builder.

1. Launch your company and re-index the database - Before you 
can work in Sage Master Builder company data, you have to re-index 
the databases of each company that you do work in. This process 
brings the company databases into conformation with new version of 
the program. 

For instructions, launch the Sage Master Builder Help viewer and 
search using the Help search shortcut “indexdatabase.” 

2. Re-schedule your reports - If you had to delete scheduled reports 
that would have interfered with the upgrade installation, return to the 
report scheduling window and re-schedule your reports. 

For instructions, launch the Sage Master Builder Help viewer and search 
using the Help search shortcut “schedulereports.” More topics about 
scheduling reports are located at the end of the topic “About report 
scheduling.” 

Related topics...

About upgrading Sage Master Builder

Important: 

You only have to re-index each company’s database one 
time from one computer using 7-4 Rebuild Indexes. 

Related topics...

About upgrading Sage Master Builder
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About re-installing and changing the computer designation

Re-installing Sage Master Builder on a computer that is the Sage license 
server does not re-install the License Administration Tool or change the 
Manage License settings for your product. 

If you choose to re-install Sage Master Builder over an existing 
installation, the installation process re-installs the software using the 
options that were selected in the initial installation. Therefore, after re-
installation, a Sage license server computer remains a Sage license server 
and a client workstation remains a client workstation.

To change an installation option by re-installing (i.e., changing a client 
workstation into the Sage license server or the Sage license server into a 
client workstation), you have to: 

1. Uninstall Sage Master Builder Licensing from the Control Panel > 
Add or Remove Programs window. 

2. Re-install Sage Master Builder following the instructions for initial 
installation.
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Managing Your License with the 
License Administration Tool
This chapter provides information about the following:

• License Administration Tool

• Administrator User and Administration Password

• Monitoring Product and Feature Use

• Managing Licenses

• Managing Reservations

• Troubleshooting Network Disconnection Issues
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License Administration Tool

About the License Administration Tool for Sage Master Builder 

When you purchase Sage Master Builder software, it includes the 
License Administration Tool. Using the License Administration Tool, 
you can import license files, activate licenses, reserve the use of products 
and features, and monitor the use of products and features. This tool also 
supports site licenses and floating use licenses. During software 
installation, the License Administration Tool is automatically installed 
on the computer that the software installer designates as the Sage license 
server.

What is the Sage license server, and why do I need it?

When you purchase Sage Master Builder software, it includes the 
License Administration Tool. Using the License Administration Tool, 
you can import license files, activate licenses, reserve the use of products 
and features, and monitor the use of products and features. This tool also 
supports site licenses and floating use licenses. During software 
installation, the License Administration Tool is automatically installed 
on the computer that the software installer designates as the Sage license 
server.

Where is the Sage license server located?

The Sage license server is software running on a computer on your 
network that manages the Sage Master Builder products and features that 
you purchased. Products and features can be a “core product,” additional 
“modules,” and a number of “license uses.” The computers running your 
Sage Master Builder have to be connected to the computer running the 
Sage license server so that the correct products, features, and number of 
license uses are available to you. 

Important:

Before you can use Sage Master Builder with your activated 
license, you have to specify the computer on your network 
that is the Sage license server when you launch Sage 
Master Builder. 
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Administrator User and Administration Password

About the administrator user and administrator password

To activate and manage your Sage Master Builder product license, you 
must log on to the License Administration Tool as Administrator. You 
do that by selecting to log on as the Administrator and set the 
administrator user password. At any launch of the License 
Administration Tool, you have the option to log on as Other (View 
Only), which requires no password. 

Only the administrator user has rights to access the License 
Administration Tool to perform such tasks as:

• Adding and updating the product license

• Changing the Administrator password

• Setting up license groups and license use reservations

After an administrator password has been set, subsequent launches of the 
License Administration Tool display two links:

Related topics...

About the administrator user and administrator password

Setting the Administrator password

Important:

• We strongly recommend that you write down your 
License Administration Tool Administrator password 
and save it in a convenient place. If you forget your 
password, you have to call Sage Customer Support to 
re-set it. 

• Before the Administrator can log on and manage the 
license using the License Administration Tool from a 
client workstation computer, the \MB7 folder must be 
shared on the Sage license server computer. For 
information about sharing folders, see the Windows 
Help.
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• I forgot my password

• Change password

Clicking either of these links launches other windows to either change 
your password or re-set the password. 

Setting the Administrator password

During installation with the Launch the License Administration Tool 
check box selected, the License Administration Tool displays the Logon 
Administrator Password window automatically. Otherwise, you can 
launch the Logon Administration Password window by double-
clicking the License Administration Tool desktop icon. 

To set the Administrator password: 

1. In the Password text box, type a password. 

2. In the Confirm Password text box, re-type the password and click 
OK.

The License Administration Tool window opens. From this window 
you can manage your product license, license groups, and license use 
reservations.

Related topics...

Setting the administrator password

Changing the administrator password

Re-setting a forgotten administrator password

Note: 

Your License Administration Tool password is 
case-sensitive.

Related topics...

About the administrator user and administrator password

Changing the administrator password

Re-setting a forgotten administrator user password
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Changing the Administrator password

After initially setting your administrator user password, every 
subsequent launch of the License Administration Tool displays the 
Logon Administrator Password window. 

The window displays two links, I forgot my password and Change 
password. Instead of typing your password and launching the License 
Administration Tool window, you can click the Change password link 
to display the Change Password window. 

To change the Administrator password: 

1. On the Logon Administration Password window, click the Change 
password link.

The Change Password window opens.

2. In the Old Password text box, type the old password. 

3. In the New Password text box, type a new password. 

4. In the Confirm Password text box, re-type the new password and 
click OK.

The License Administration Tool window opens. From this window 
you can manage your product license, license groups, and license use 
reservations. 

Re-setting a forgotten administrator password

To re-set your Administrator password, you have to contact Sage 
Customer Support.

Note: 

Your License Administration Tool password is 
case-sensitive.

Related topics...

About the administrator user and administrator password

Setting the administrator password

Re-setting a forgotten administrator password
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To re-set a forgotten Administrator password: 

1. On the Logon Administrator Password window, click I forgot my 
password. 

The Forgotten Password window opens. 

2. Read the instructions, phone Sage Customer Support at 800-866-
8049, and type the temporary password they provide you in the text 
box.

You can also ask them to send you the temporary password in an 
email message. From that message, you can copy and paste the 
temporary password into the Forgotten Password text box. 

3. Click OK. 

The Change Password window opens.

4. In the New Password text box, type a password. 

5. In the Confirm Password text box, re-type the password and click 
OK. 

The License Administration Tool window opens. From this window 
you can manage your product license, license groups, and license use 
reservations. 

Important: 

Type the temporary password exactly as the Sage 
Customer Support names each letter as either upper-case 
or lower-case. 

Related topics...

About the administrator user and administrator password

Setting the administrator password

Changing the administrator user password
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Monitoring Product and Feature Use

About monitoring product and feature use

After activating licenses and reserving the use of Sage Master Builder, 
you can monitor the license use and group reservations from the License 
Administration Tool window.

When you select a Floating use License Type with reservations in the 
License Administration Tool window, the window displays the 
following grids:

• License details for product line

• Summary of product or feature use

• Current users of the product or feature

When you select a Floating use License Type without reservations, the 
window displays the license details Current users of the product or 
feature grid.

When you select a Site License Type, the window displays the license 
details grid and definitions for the Product Line, Product or Feature, 
and License Type.

License details for product line

After you add licenses, the license details grid displays the following 
information for the product line:

• Status

Tip: 

The terms you see in this topic, such as Status, License 
Type, and so forth are defined in the Glossary under 
License Administration Tool.

Note: 

If you have not added licenses, the grids on the License 
Administration Tool window are empty.
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• Product Line (Hidden by default. To display, right-click a 
column heading in the grid and select Hide/Show Columns > 
Product Line.)

• Product or Feature

• Reservations Allowed (Hidden by default. To display, right-
click a column heading in the grid and select Hide/Show 
Columns > Reservations Allowed.)

• License Type

• Total Uses

• Available Uses

• In Use

• Expiration Date

• Version

Summary of product or feature use

After you reserve the use of products and features for a floating use 
license, the Summary of product or feature use grid displays the 
following information for the license that you select in the license details 
grid.

• Reserved For

• Total

• Available

• In Use

Current users of the product or feature

After you activate floating use licenses, the Current users of the product 
or feature grid displays the following information for the license that you 
select in the license details grid.

• User Name

• Reserved Under

• Computer Name
58



 Managing Your License with the License Administration Tool
• Session ID

• In Use Since

Show and Hide Column Features

About showing or hiding columns

Use the Show/Hide Columns window to select the columns that 
you want to display in license details grid on the License 
Administration Tool window.

Showing columns

To monitor license use, you may choose to show columns. 

To show columns: 

1. From the License Administration Tool window, right-click a 
column heading in the license details grid and select Hide/Show 
Columns.

2. From the Show/Hide Columns window, select the columns that you 
want to display or click Show All.

3. Click OK.

Hiding columns

You may want to hide one or several columns for business security 
reasons. 

Related topics...

Showing columns

Hiding columns

Hiding all columns

Related topics...

About showing or hiding columns

Hiding columns

Hiding all columns
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To hide a column: 

1. From the License Administration Tool window in the license 
details grid, right-click the column heading that you want to hide.

2. Select Hide Column.

Hiding all columns

You may want to hide all the columns for business security reasons. 

To hide all columns

1. From the License Administration Tool window, right-click a 
column heading in the license details grid and select Hide/Show 
Columns.

2. From the Show/Hide Columns window, click Hide All.

3. Click OK.

Related topics...

About monitoring product and feature use

About showing or hiding columns

Hiding all columns

Note: 

You cannot hide the Product or Feature column.

Related topics...

About monitoring product and feature use

About showing or hiding columns

Hiding columns
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Managing Licenses

About managing licenses

Use the Manage Licenses window to add product keys, update product 
keys, and activate licenses.

Importing the license file

License activation is based on either importing a license file or manual 
entry of up to four product keys.Take a moment to locate your product 
keys. They are a series of 16-letter codes used to activate your license. 
They have been sent to you in a license file attached to an email from 
your Business Partner, on your Sage Master Builder packing slip, and/or 
on a sticker on the CD envelope. 

Use the Import License File window to import a license file into the 
Sage license server. 

To import the license file:

1. Open the e-mail message with the attached license file from Sage 
Software or your business partner. 

2. Save the license file attachment to the Windows desktop.

3. From the License Administration Tool window, click Manage 
Licenses.

4. From the Manage Licenses window, click import the license file.

5. From the Import License File window, select the license (.lic) file 
name and click Open.

Related topics...

Importing the license file

Adding or updating product keys

Activating licenses

Note: 

If you did not receive a license file in an email message, 
follow the instructions for adding or updating product keys.
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6. From the Manage Licenses window, click activate the licenses.

7. Click Close.

Adding or updating product keys

License activation is based on either importing a license file or manual 
entry of up to four product keys.Take a moment to locate your product 
keys. They are a series of 16-letter codes used to activate your license. 
They have been sent to you in a license file attached to an email from 
your Business Partner, on your Sage Master Builder packing slip, and/or 
on a sticker on the CD envelope. 

Use the Add or Update Product Keys window to type the product keys. 
Each time you add or make changes to licenses, you will receive new 
product keys.

To add or update product keys:

1. From the License Administration Tool window, click Manage 
Licenses.

2. From the Manage Licenses window, click type the product keys.

3.  In the Type the product keys boxes on the Add or Update 
Product Keys window, type the product keys listed on your CD 
envelope or that are printed on your packing slip.

4. On the Add or Update Product Keys window, click Accept 
Product Keys.

5. Click Accept Product Keys.

Related topics...

About managing licenses

Adding or updating product keys

Activating licenses

Note: 

If you received an e-mail message with an attached license 
file from Sage Software, follow the instructions for 
importing the license file. 
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6. On the Manage Licenses window, click activate the licenses.

7. Click Close.

Activating licenses

After importing the license file or entering product keys, you have to 
activate your licenses. 

To activate your license:

1. On the Manage Licenses window, either import the license file or 
add the product keys. 

2. Click activate the licenses. 

3. Click Close.

When you see two green check marks by Step 1 and Step 2, you know 
that your license has been activated. You can now launch the License 
Administration Tool and specify the computer on your network that is 
the Sage license server.

Managing Reservations

About managing group reservations

Use the Group and Uses columns on the Manage Reservations window 
to reserve product and feature uses for groups.

Related topics...

About managing licenses

Importing the license file

Activating licenses

Related topics...

About managing licenses

Importing the license file

Adding or updating product keys
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When a user logs in to a Sage Master Builder company, the Sage license 
server assigns a license use from the first available group to which the 
user belongs. If no reserved license uses are available, the Sage license 
server assigns a license use from the unreserved license uses. 

Setting up group reservations

Use the Group and User columns on the Manage Reservations window 
to reserve license uses for groups.

When a user logs in to a Sage Master Builder company, the Sage license 
server assigns a license use from the first available group to which the 
user belongs. If no group reservations are available, the Sage license 
server assigns a license use from the unreserved uses.

To set up group reservations:

1. From the License Administration Tool window, click Manage 
Reservations. 

The Manage Reservations window for this product line opens.

2. In the Group column, type the name of the first group of users.

You can assign any group name that works for your purposes. 

3. In the Uses column, type the number of license uses that you want to 
reserve for this group.

Important: 

If no reserved or unreserved license uses are available, 
you cannot launch Sage Master Builder connected. You can 
only launch the program disconnected with exclusive 
access. 

Important: 

You must import the license file or enter product keys 
before you set up group reservations.
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4. Repeat steps 2 and 3 for each group.

5. Click OK.

Removing group reservations

You may need to create new reservation groups when you hire new 
employees or open a new office. 

To remove group reservations: 

1. From the License Administration Tool window, click Manage 
Reservations.

2. From the Management Reservations window, select the row for the 
Group that you want to remove.

3. Click the Delete the selected row (the X button). 

4. Click OK.

Important: 

The total number of Uses for all groups cannot exceed the 
Total Uses listed for this product on the License 
Administration Tool window. 

Tip: 

If you want to retain some unreserved license uses, do not 
reserve all license uses for groups.

Related topics...

About managing licenses

Activating licenses

Removing group reservations
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Troubleshooting Network Disconnection Issues

Disconnected from the network

If a workstation is disconnected from the Sage license server while you 
are using the License Administration Tool, the system displays a 
Disconnected from the License Server message.

Since Sage Software products run on your company's network, it is 
important to maintain the network connection between workstations and 
the Sage license server. When your workstation is disconnected from the 
Sage license server, you cannot perform license administration functions 
using the License Administration Tool on the workstation. 

To reconnect to the license server:

1. Wait a few minutes, and then try again to use the License 
Administration Tool.

2. If the workstation is still disconnected, check whether the network 
cable is unplugged. For details, see Network cable unplugged.

3. If the workstation remains disconnected, check whether a network 
drive is disconnected. For details, see Disconnected network drive.

4. Contact your network administrator.

Related topics...

About managing licenses

Importing the license file

Activating licenses

About managing group reservations

Setting up group reservations

Note: 

This information does not apply if you are running Sage 
Master Builder and the Sage license server on one 
computer as a stand-alone installation. 
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When the connection is restored, the License Administration Tool returns 
to normal and you can perform any of its functions.

Network cable unplugged

When the network cable is unplugged from your workstation, you cannot 
perform license administration functions using the License 
Administration Tool. 

To check whether a network cable is unplugged:

1. Check the notification area, at the far right of the taskbar, for this 
message: A network cable is unplugged.

2. If you see this message, reconnect the network cable to the 
workstation.

3. If you do not see this message, check the network connections.

a. Click Start, and select Control Panel > Network Connections.

b. In the LAN or High-Speed Internet section, check the Status 
of the Local Area Connection.

c. If the Status is Network cable unplugged, reconnect the 
network cable to the workstation.

d. If the Status is Connected, the network cable is connected to the 
workstation.

4. Try to use the License Administrator Tool.

Related topics...

Network cable unplugged

Disconnected network drive

Related topics...

Disconnected from the network

Disconnected network drive
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Disconnected network drive

When your workstation is disconnected from the network drive for the 
Sage license server, you cannot perform license administration functions 
using the License Administration Tool. 

To check whether a network drive is disconnected:

1. Click Start, and select My Computer.

2. In the Network Drives section, check the Type column for the 
network drive for the Sage license server.

3. If the Type is Disconnected Network Drive, select the network 
drive and then select another network drive.

4. If the Type changes to Network Drive, try to use the License 
Administrator Tool.

5. If the Type remains Disconnected Network Drive, contact your 
network administrator.

Related topics...

Disconnected from the network

Network cable unplugged
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License Use and Sage Master Builder
This chapter provides information about the following:

• Specify Sage License Server

• Running Sage Master Builder Connected
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Specify Sage License Server

About specifying the Sage License Server

Before you can use Sage Master Builder with your activated license, you 
have to specify the computer on your network that is the Sage license 
server. There are two ways to specify the Sage license server. 

• You can select the computer from the list of computers on your 
network or

• You can enter the IP Address or name of the computer 

Selecting the Sage license server computer

One method is to select the computer running the Sage license server 
from the list of network computers. 

To select the computer running Sage license server from the 
list of network computers:

1. On the Select License Server window from the list of network 
computers, select the computer running the Sage license server. 

2. Click OK. 

Related topics...

Selecting the Sage license server computer

Entering the IP Address or name of the computer

Determining the name of a computer

Determining the IP Address of a computer

What is an IP Address?

What is a server?

Note: 

To use this method of selecting a server from the list of 
network computers, you have already clicked the 
appropriate link on the Specify Sage License Server 
window.
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Entering the IP Address or name of the computer

One method is to enter the IP Address or name of the computer running 
the Sage license server. 

To enter the IP Address or name of the computer running the 
Sage license server:

1. In the text box, type the IP Address or name of the computer. 

2. Click OK.

Determining the name of a computer

Related topics...

About specifying the Sage license server

Entering the IP Address or name of the computer

Determining the name of a computer

Determining the IP Address of a computer

Note: 

To use this method of selecting a server from the list of 
network computers, you have already clicked the 
appropriate link on the Specify Sage License Server 
window. 

Related topics...

About specifying the Sage license server

Selecting the Sage license server computer

Determining the name of a computer

Determining the IP Address of a computer

What is an IP Address?

Note: 

If you are trying to determine the name of the computer 
running the Sage license server, you must complete this 
procedure on that computer.
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To determine the name of a computer: 

1. Click Start, Settings, and then Control Panel. 

2. From the list, scroll to and double-click System. 

3. The System Properties window appears.

4. Locate the line Full computer name, and write it down or type it 
into a note that you can print. 

5. Click Cancel. 

Determining the IP Address of a computer

To determine the IP Address of a computer: 

1. Click Start, then Run. 

2. In the Open text box, type cmd, then click OK.

3. The \Windows\...\cmd.exe window appears.

4. At the prompt, type ipconfig. 

For example, you might see H:\. Type ipconfig after the drive letter. 
When you press the ENTER key, the system displays several 
address, among which is the IP Address of the computer. You see 
this: 
IP Address . . . . . . . .172.20.22.142

Related topics...

About specifying the Sage license server

Entering the IP Address or name of the computer

Determining the IP Address of a computer

Note: 

If you are trying to determine the IP Address computer 
running the Sage license server, you must complete this 
procedure on that computer. 
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What is an IP Address?

Every computer connected to the Internet is assigned a unique number 
known as an Internet Protocol (IP) address. This numeric address of a 
computer on the Internet is written as a set of four numbers separated by 
periods (each number can range from 0 to 255). An example of an IP 
Address is 123.123.4.5. 

What is a server?

There are many kinds of servers. Some servers are denoted by their 
hardware configuration and a specialized operating system. Other servers 
consist of specialized software applications running on standard 
computers. 

Some servers are called “file servers” and may be a powerful computer 
dedicated to storing files and data. For example, Sage Master Builder 
company data can be stored on a file server computer. Any Sage Master 
Builder user on the same network as the file server computer can access 
and store data there. 

Related topics...

About specifying the Sage license server

Entering the IP Address or name of the computer

What is an IP Address?

What is a server?

Note: 

If you are trying to determine the IP Address of the 
computer running the Sage license server, you must 
complete the procedure on that computer. 

Related topics...

About specifying the Sage license server

Entering the IP Address or name of the computer

Determining the IP Address of a computer

What is a server?
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A server can also be a software application that provides a specific kind 
of service to client software running on other computers. The term server 
can refer to a particular piece of software, such as the Sage license server. 
A single computer may have several different server software 
applications running on it, thus providing many different servers to client 
workstations running on a network.

Running Sage Master Builder Connected

Launching and running Sage Master Builder connected

(This topic presents the perspective of a Sage Master Builder user.)

The desired Sage License Server Connection State is:
Connected: License use acquired. This connection state allow you to 
use all the power of Sage Master Builder product that you purchased and 
licensed. Running connected means that your computer is connected to 
the Sage license server, and there is a license use available to you. 

Prerequisites for a launching and running connected include:

• An activated Sage Master Builder product license.The administrator 
user activates the product license using the functions of the License 
Administration Tool.

• A network connection, if you are on a network. This only pertains to 
working in a network environment and does not pertain to a single 
computer running in a stand-alone environment.

•  The Sage license server that has been specified from the computer 
running Sage Master Builder. 

• An available license use.

• Being a user and having access to a Sage Master Builder company.

Note: 

If you are having a problem running Sage Master Builder 
connected, it is very likely a network problem or your 
computer’s connectivity to your network. If problems 
persist, consult with your local system administrator. 
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To launch and run Sage Master Builder connected:

1. Double-click the Sage Master Builder desktop icon.

2. The Specify Sage License Server window appears. 

3. Choose one of the following: 

• Select the Sage license server from the list of computer on 
your network.

• Enter an IP Address or name of the computer that is the 
Sage license server.

4. When you have satisfied the conditions to specify the Sage license 
server, click OK. 

Sage Master Builder begins its launch process. 

5. (Sage Master Builder Enterprise Edition only) On the Connect to 
Sage Master Builder Server window, select your network and click 
OK.

6. On the Company List window, select a company, or click Cancel. 

7. From the Company List window, select a company. 

8. On the User Name and Password window, enter your user name 
and password. 

9. Sage Master Builder opens the company. 

You are now running Sage Master Builder connected. 

About the Sage License Server Connection states

(This topic presents the perspective of a Sage Master Builder user.)

You can view the current connection state to the Sage license server in 
the About Sage Master Builder window. Your connection state is 
defined by several factors involving your network connectivity and the 
availability of license uses. The following table presents connection state 
definitions: 

Note: 

For more information about the finding your company on 
the Company List window, see the following section. 
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Sage license server 
connection state

About Sage Master Builder 
window displays

Connected
You have launched Sage 
Master Builder but not 
logged in to a company yet.

Connected: License use not 
acquired. 

Connected
You have successfully 
logged in to a company.

Connected: License use acquired.

Connected
After a successful login, you 
have chosen to open a new 
company, change user 
name/access, or change 
the Sage license server.

Connected: License use returned.

Originally connected, later 
disconnected, now 
reconnected 
You have successfully 
logged in, but you lost 
connection to Sage license 
server and the license use 
has expired. Now you are 
connected again but when 
you try to acquire a license 
use, no uses are available.

Connected: License use lost.

Disconnected 
You are disconnected at 
launch or at subsequent log 
in when selecting a 
company.

Disconnected: x uses remaining, or 
Disconnected: One use remaining.

Connected
Your educational or trial 
product has expired. 

Activated license has expired. 

Connected
Your unauthorized product 
has expired. 

The seven-day grace period for 
license activation has expired. 
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Viewing the Sage license server connection state

You can view the current connection state of the Sage license server. This 
may help you in situations where your Sage license server connection 
status is not what you expect it to be. Viewing the connection state can 
help you troubleshoot problems. 

To view the Sage license server connection state: 

1. From the Sage Master Builder main window, click Help, then click 
About Sage Master Builder. 

The About Sage Master Builder window appears.

2. In the lower right of the window just above the Close button, look 
for Sage License Server Connection State. 

The text in the box displays the current connection state. 

Company List window

About the Company List window

During installation, you have the option to install Sage Master Builder on 
a specific local drive, such as C:, D:, etc. When you launch Sage Master 
Builder, the first window (Standard Edition) or second window 
(Enterprise Edition) that appears is Company List. From this window, 
you select the location of company you want to open, then you select the 
company itself, and click OK. 

For example, if you have installed Sage Master Builder and the Sample 
Company on local drive C:, and this is the first time you have launched 
the program, then the program displays the local drive, and the Sample 
Company appears in the list directly below. 

Note: 

If the computer running the Sage license server becomes 
disconnected from the other computers on your network, or 
if your computer becomes disconnected from the Sage 
license server, you may see an alert message from Sage 
Master Builder telling you that you are disconnected. 
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In most business situations, the company that you use to manage your 
business is not located on your local computer. It is located on a server 
computer on your local network. The server computer could be a 
dedicated server computer in a client/server configuration or it could be a 
colleague’s computer in the next office using a peer-to-peer 
configuration. 

If you are working in a network environment, clicking the drop-down 
arrow displays all the local drives and all the network drives that you 
have access to. In the following graphic, you can see a list of network 
drives that have been mapped to from this computer.
78



 License Use and Sage Master Builder
If you can see the drive in the list, then you can access the Sage Master 
Builder company located on that drive. If you cannot see the drive where 
the company is located, then ask yourself these questions. You may have 
to consult with your network administrator to locate the drive where your 
company is located. 

1. Have you lost your network connection? If you have, then you 
cannot access network drives and the Sage Master Builder company. 

2. Has the server lost its network access or crashed? If that has 
happened, then you can access the server and the company. 

3. Has the company been moved to a different computer and drive? If 
that’s true, the you have to map to the network drive in its new 
location. 

Mapping a network drive to access a company

You may have to map to a network drive to access a Sage Master Builder 
company if it is not located on a drive on your local computer or it has 
been moved to a different drive. When you create a Sage Master Builder 
company on a different network drive, the program creates an \MB7 
folder and the new company under that folder. 

For example, you have to map to the Sage Master Builder company 
located on network drive Z. 
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To map a network drive: 

1. On your Windows desktop, click Start > Explore. 

2. On the tool bar, click Tools > Map Network Drive.

3. On the Map Network Drive window, click Browse. 

4. Locate the drive, and then click OK. 

5. On the Map Network Drive window, click Finish. 

6. Launch Sage Master Builder. 

7. On the Company List window, select drive Z. 

8. Select the company, and click OK. 

Related topics...
About Sage License Server Connection State

Mapping a network drive
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Special Configuration
This appendix provides information about the following:

• Windows Vista Business Operating System

• Windows Server 2003 Operating System

• Windows XP Professional Operating System

• Windows 2000 Servers Operating System

• Windows 2000 Professional (SP2) Operating System

• Citrix and Terminal Servers
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Windows Vista Business Operating System

Launching Sage Master Builder to run as administrator for 
scheduling reports

Microsoft Windows has changed security rules in the Vista operating 
system to make your computer more secure. If you are running Sage 
Master Builder as a typical user, then you have limited privileges in some 
areas of the program, such as saving a report schedule or viewing My 
Scheduled Reports. So, to save a report schedule or view My Scheduled 
reports, you must launch Sage Master Builder with the command to 
either Run as administrator or Run this program as an 
administrator.

When you select either command, the settings are limited to you. Your 
settings to run Sage Master Builder as administrator do not affect the 
next person who logs on and launches Sage Master Builder from this 
computer. Your settings on this computer can either be temporary or 
persistent. For example, when you select Run as administrator, you run 
the program as administrator for that session only. When you select Run 
this program as an administrator, you set program properties to 
always run the program as administrator when you log on to this 
computer. 

Important: 

On computers running Vista, scheduling Sage Master 
Builder reports and viewing My Scheduled Reports requires 
that you to “run as administrator” or to “run the program 
as administrator,” two similar command. 

Note: 

Run as administrator and Run this program as an 
administrator are not related to Vista operating system 
user groups but are limited to a specific program you are 
running. 
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To set Run as administrator:

1. On your Windows desktop, right-click the Sage Master Builder 
program icon. 

2. From the drop-down menu, to launch the program, click Run as 
administrator. 

To set Run this program as an administrator: 

1. On your Windows desktop, right-click the Sage Master Builder 
program icon. 

2. From the drop-down menu, click Properties. 

3. On the Sage Master Builder Properties window, click the 
Compatibility tab. 

4. Under Privileges Level, select Run this program as an 
administrator.

5. Click Apply, and then click OK. 

Vista and CodeBase Server

Note: 

Selecting Run as administrator only runs the current 
session of running Sage Master Builder. The setting does 
not persist. 

Note: 

Selecting Run this program as an administrator always 
runs the program with these properties when you launch 
the program on this computer. The setting persists. 

Important: 

(Sage Master Builder Enterprise Edition only) You cannot 
install CodeBase Server for Sage Master Builder on a 
computer running the Windows Vista Business operating 
system. You can only install it on computers running 
Windows 2000 or Windows Server 2003. 
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Running the Sage license server on Vista

A computer running the Vista Business operating system cannot be a 
Sage license server computer for client workstation computers running 
the Vista Business operating system. Consider using a different computer 
on your network to be the Sage license server. Any supported operating 
system can be used in place of Vista, for example, Windows XP. 

Vista sleep mode prevents computers from obtaining a license 
use

If a computer running the Vista Business operating system is used as a 
license server, when it goes into sleep mode other computers on the 
network can’t obtain a license. Possible resolutions are: 

• Use a different computer on your network to be the Sage license 
server. Any supported operating system can be used in place of Vista, 
for example, Windows XP.

• Set Sleep Mode on your license server computer to “Never.”

To set the Sleep Mode to “Never:”

1. Start > Control Panel > System Maintenance > Power Option. 

2. Select Change when computer sleeps. 

3. From the Put computer to sleep list, select Never. 

Important: 

Read this information if you are running Vista business 
operating system on your office computers.

Important: 

Read this information if you are running Vista business 
operating system on your office computers.
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Sage licensing cannot auto-start on Vista

The Sage Licensing service (i.e. the Sage Service Host) cannot auto-start 
on computers running the Vista operating system. If the service stops and 
can’t auto-start, the program displays a message advising you to take 
further action to resolve this issue. 

Sage licensing not installed to Vista over network

On a computer running the Vista operating system, installing Sage 
Master Builder by mapping to a network drive does not install the Sage 
licensing (i.e., the Sage Service Host). To resolve this problem, install 
Sage Master Builder from the installation Version 13 CD. 

Vista displays “Unidentified Publisher” message

Vista displays an “Unidentified Publisher” message when the Sage 
Master Builder user asks for elevated privileges (for instance, when you 
request to run the program as administrator). You can click OK and 
continue without any problems. 

Windows Server 2003 Operating System

Important: 

Read this information if you are running Vista business 
operating system on your office computers.

Important: 

Read this information if you are running Vista business 
operating system on your office computers.

Note: 

Configuration for Windows Small Business Server 2003 is 
the same as configuration for Windows Server 2003.
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Configuring Windows Server 2003 date format

It is necessary when using Windows Server 2003 to configure the date 
format. 

To configure the Windows Server 2003 date format:

1. Click the Start button, point to Control Panel, then click Regional 
and Language Options.

2. On the Regional and Language Options dialog box, on the 
Regional Options tab, click the Customize... button.

3. On the Customize Regional Options dialog box, click the Date tab.

4. Under Short date, from the Short date format drop-down list, 
select MM/dd/yyyy.

5. Click OK.

6. To close Customize Regional Options, click OK again.

Setting up Windows Server 2003 for PDF and RTF printers

In Windows Server 2003, Standard Edition and Windows Server 2003, 
Enterprise Edition, the installation of kernel-mode drivers is blocked by 
default. Before you can install Sage Master Builder PDF and RTF 
printers with Windows 2003 Server, you have to unblock the installation 
of the kernel-mode drivers and edit the Group Policy.

To unblock the installation and edit the Group Policy: 

1. On your Windows Server desktop, click Start, then Run....

The Run dialog box opens.

2. In the Open: text box, enter gpedit.msc, and then press ENTER.

The Group Policy window opens.

3. In the left pane, on the Tree tab, double-click the Administrative 
Templates folder.

4. Then double-click the Printers folder.

5. In the right pane, in the Setting list, find and set the state of the 
setting for Disallow installation of printers using kernel-mode 
drivers to Disable.
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Windows XP Professional (SP2) Operating System

Configuring the Windows XP Professional date format

To configure the date format:

1. Click the Start button, point to Settings, and click Control Panel.

2. Double-click the Regional and Language Options icon, and click 
the Regional Options tab.

3. Click the Customize button and the Date tab.

4. In the Short Date Format list, select MM/dd/yyyy.

5. Click OK.

Windows Server 2000 (SP3) Operating System

Configuring Windows Server 2000 Server (SP3) date format

To configure Windows Server 2000 servers:

1. On the Start menu, point to Settings, then click Control Panel.

2. Double-click the Regional Options icon.

3. Click the Date tab.

4. In the Short Date Style list, click MM/dd/yyyy.

5. Click OK.

Windows 2000 Professional (SP4 or newer) 
Operating System

Configuring the Windows 2000 Professional date format

To configure Windows 2000 workstations, you first modify the date 
format and then disable the disk write caching.
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To configure the date format:

1. Click the Start button, point to Settings, and click Control Panel.

2. Double-click the Regional Settings icon, and click the Date tab.

3. In the Short Date Style list, click MM/dd/yyyy.

4. Click OK.

Disabling disk-write caching for Windows 2000 Professional 
(SP4 or newer) workstations

To configure Windows 2000 workstations, you first modify the date 
format and then disable the disk write caching.

It is necessary to disable the disk write caching for Windows 2000. You 
can obtain a copy of Microsoft documents Q259716 and Q233541 via 
fax-back from Microsoft or through their web site at:
www.microsoft.com.
This procedure disables the disk write caching only for shared/mapped 
network drives.

To disable disk write caching:

1. Double-click the My Computer icon on your desktop. 

Important: 

When appropriate, disable disk write caching for clients, 
but do not disable disk write caching for servers. 

Caution!
Windows 2000's disk-write caching is hardware dependent. 
If the hardware is old, it may not have the ability to be 
turned off and may have the potential of causing a loss of 
data.

Caution!
In situations where the program may be interrupted by a 
power outage or a system crash, a reliable backup process 
must be in place to protect your data.
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2. Right-click your drive icon. 

3. Click Properties. 

4. Click the Hardware tab, and ensure that the drive you want to test is 
selected.

5. Click the Properties button and then the Disk properties tab.

6. Clear Write cache enabled.

7. Click OK, then click OK again to return to the My Computer 
window.

Citrix and Terminal Servers

Using Citrix and Terminal Server with Sage Master Builder

Many people use Citrix and Terminal Server to manage remote access to 
their local area network (LAN). If Sage Master Builder is installed on the 
computer running Citrix or Terminal Server and on your laptop, then you 
may log on to the computer running Citrix or Terminal Server with your 
laptop and work in Sage Master Builder on your LAN. This enables you 
to work from home, from a job site, or from any number of other remote 
locations. 

We recommend that you use DOS commands to change the operating 
mode from “execute” to “install” and then back to “execute.” When 
using the DOS commands to install, you may install the Sage Master 
Builder software as you would on any desktop or Windows server 
operating system that meets Sage Master Builder requirements.

Caution!
On some computers, disabling the disk write caching is not 
permanent. To test your computer, follow the instructions 
above and then restart Windows 2000. Repeat steps 1-6. 
If Write cache enabled is again checked, your hard drive 
does not support the permanent disabling of disk write 
caching.
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Installing on computers running Citrix and Terminal Server 
using DOS commands

To install using DOS commands:

1. Click Start, then Run. 

2. On the Run window, in the Open drop-down box, type cmd, and 
press the ENTER key. 

The \Windows\...\cmd.exe window appears.

3. At the prompt, type change user /install, and press the 
ENTER key.

This enables the install mode. 

4. Install the Sage Master Builder software as you would on a typical 
workstation or Windows Server.

5. At the end of the installation process, choose to launch the License 
Administration Tool. 

6. Using the License Administration Tool window, manage your license 
and activate it. 

7. After activation, click Start, then Run. 

8. On the Run window, in the Open drop-down box, type cmd, and 
press the ENTER key.

9. The \Windows\...\cmd.exe window appears. 

10. At the prompt, type change user /execute. 

This enables the execute mode, which is the default mode for 
running Citrix and Terminal Server. 

11. Exit the Run window. 

12. Restart the server. 
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Important:

• Before users will be able to launch Sage Master 
Builder through the Terminal Server, the server must be 
restarted. 

• If this message appears: “Install mode does not apply 
to a terminal server configured for remote 
administration,” then it is not necessary to enable the 
install mode. You may install the Sage Master Builder 
software as you would on a typical workstation.
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Sage Master Builder API
This appendix provides information about the following:

Overview of the Sage Master Builder API
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Overview of the Sage Master Builder API

About Sage Master Builder API

Sage Master Builder is one of the premier software tools available for the 
construction industry. However, because there are so many vertical 
industries within the construction industry as a whole, there are many 
needs that cannot be entirely fulfilled by a single software program, no 
matter how rich it is in functionality. 

The API (as part of the Software Development Kit, or SDK) has been 
developed to respond to these needs. It allows third-party developers to 
create applications with features more precisely targeted for highly 
specific market segments while at the same time leveraging the 
substantial functionality already provided by Sage Master Builder. Thus, 
for example, a project estimation application can integrate with Sage 
Master Builder in order to use Sage Master Builder accounting and 
project management features. Such a program has been developed by 
Sage Timberline Office.

Third-party developers using the API benefit from faster implementation 
times because they don’t need to reinvent all the Sage Master Builder 
functionality. Third-party developers also benefit because their 
application can attract the immediate interest of existing Sage Master 
Builder customers.

To view the product developed for Sage Master Builder using the API, 
browse to this link:

http://www.sagemasterbuilder.com/products/p_a_overview.asp 

Important:

The following information is provided to give Sage Master 
Builder users a brief introduction using the API program. 
For complete instructions on using the Sage Master Builder 
API, refer to the Sage Master Builder SDK Developer Guide 
or visit the Developer Network Program: 

http://www.sagemasterbuilder.com/services/
s_a_mbdn.asp 
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API installation and company access

The Sage Master Builder and the API component are installed on the 
same computer and drive automatically. During installation, a shortcut 
for the API is placed in the Windows Start > Programs list under Sage 
Master Builder > Sage Master Builder API. 

The Sage Master Builder application program interface (API) allows you 
to use third-party programs to perform the same tasks that you would 
perform when using different Sage Master Builder windows as a typical 
user. The API allows the third-party program to insert, as well as delete, 
modify, or retrieve data from one or more existing Sage Master Builder 
company databases.

When you are using the API to access Sage Master Builder company 
data, the Sage Master Builder program does not have to be running. The 
API simply needs some of its files. Similarly, if the target company 
databases are on another system connected to your system via a network 
connection, Sage Master Builder need not be present or running on those 
remote systems, although it can be. 

You have to perform several steps in the other program before you can 
import and export data between programs using the API. For example, 
you may have to: 

• Specify a job cost interface type for databases and/or estimates 
files as Sage Master Builder 

• Identify a specific Sage Master Builder company

• Enter a user name

• Enter a password

Important: 

• Using the Sage Master Builder API to access Sage 
Master Builder company data requires a license use. 
That is why you must set up an API security group using 
7-3-1 Security Groups.

• Then you have to assign a user to the API security 
group using 7-3-2 User List.
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System requirements for Sage Master Builder API

If you are using the Sage Master Builder API, the minimum and 
recommended system requirements may vary. These requirements must 
be considered in addition to the recommended system requirements for 
running Sage Master Builder or the Sage Master Builder Enterprise 
Edition. 

It may be necessary to increase the processor speed, memory and/or disk 
space of your system depending upon the requirements of the third-party 
application using the API. Please consult with your third-party vendor to 
determine what changes, if any, should be made to your hardware 
configuration in order to meet your desired performance criteria.

Installing SDK samples and test programs

All the SDK files are in the \SMBAPI folder on the Sage Master Builder 
installation CD. 

To install SDK samples and test programs:

1. On the installation CD, browse to the \SMBAPI folder. 

2. Copy the \SMBAPI folder to the \MB7 folder on your hard drive.

About the Sage Master Builder API Administration window

The Sage Master Builder API Administration window displays several 
areas, buttons, and menu items. 

API Status area - Displays whether or not the API is Not Accepting 
Requests or is Accepting Requests. Before the API can accept requests, it 
must be initialized. Clicking [Start] initializes the API. 

Configuration area - Three configurations that are controlled by MB 
Data Drive.

• By default, the API is set to your local drive, for example, C: (XP). 
The API accesses company data on that drive. 

• When you click the drop-down arrow, you see a list of mapped 
drives. If you select one of these drives, the API accesses a company 
database on that drive. 
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• If you select the Access Master Builder Enterprise check box, it 
opens boxes for setting parameters for Sage Master Builder 
Enterprise client-server configuration. You can type information for:

• Server IP – The IP Address or name of the Enterprise server

• Server Port – The Enterprise server port number

• User ID – Enterprise server user ID. 

• Password – Enterprise server user ID. Note: No user ID is 
needed for “public.”

File > Logging – When this command is selected, (check mark 
indicator) the API creates an mbapi.log file in the \MB7\Programs folder. 
It logs instances of: 

• Database table locking

• Enterprise roll-back of transactions

• Failure to request or check in a license use

File > Exit – Exit the program.

Edit > Security - Opens Sage Master Builder API Security Setting 
window where you select the objects you want to be available for API 
applications. 

Help > About the API version.

Caution!
You can specify only one drive, mapped drive, or network 
location for the company databases. If you are not using 
Sage Master Builder Enterprise and have multiple 
locations, you cannot dynamically switch between them. 
Instead, the API executable has to be stopped and 
restarted for each after selecting the correct drive location.
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Launching the API and starting the API service

The first time you launch the API Administration program, it registers 
itself in the Windows registry.

You must launch the API Administration program and start the service 
manually in order for requests from the program to be processed.

To launch API and start the API service:

1. From the Windows Start menu, click Programs, point to Sage 
Master Builder, then click Sage Master Builder API.

The Sage Master Builder API Administration window appears.

2. By default, Sage Master Builder expects the company databases to 
be on drive C:\. Do one of the following: 

• If the company databases are on another hard drive or mapped 
network drive, click the drop-down list button for the MB Data 
Drive text box, and select the appropriate drive.

• (Sage Master Builder Enterprise Edition only) If the company 
databases are located at a networked location on a server, do the 
following:

i. Select the Access Sage Master Builder Enterprise option 
box.

ii. Specify the Sage Master Builder server’s IP address, Server 
Port, User ID, and Password supplied to you by your Sage 
Master Builder server administrator. 
For more details about launching the API and starting the 
API service when running Sage Master Builder Enterprise 
Edition, see the Enterprise Edition Help under 7-Utilities. 

Caution!
You can specify only one drive/mapped drive, or network 
location for the company databases. If you are not using 
Sage Master Builder Enterprise and have multiple 
locations, you cannot dynamically switch between them. 
Instead, the API Administration service has to be stopped 
and restarted for each after selecting the correct drive 
location.
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3. Click Start to start the API service.

4. If you have not already configured the API security settings, do so 
now. By default, SDK access to Sage Master Builder objects is 
disabled until you configure the API security settings. 

States of the API

There are three distinct states of the API:

• The API has not been launched.

• The API has been launched, but the API service has not started.

• The API has been launched and the API service has been started.

In the first case, if the application tries to access the API, an error 
message will be returned to the application stating that there has been an 
automation error.

In the second case, if the application tries to access the API, an error 
message will be returned to the application stating that it is not accepting 
requests.

Important:

• By default, API access to Sage Master Builder objects 
is disabled until you configure the program.

• The meaning of “service” in Sage Master Builder API 
does NOT connote “service” in Windows 2000 
Professional, and Windows XP Professional system 
service.

Important:

• By default, API access to Sage Master Builder objects 
is disabled until you configure the API.

• The meaning of “service” in Sage Master Builder API 
does NOT connote “service” in Windows 2000 
Professional, and Windows XP Professional system 
service.
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Configuring the API security settings

By default, the API service has all Sage Master Builder object types 
disabled. You need to launch the API Administration window and select 
the objects that you want to enable for SDK access. A good general 
policy is to be as restrictive as possible.

The selections are specific to the machine that you are configuring. The 
settings will be the same for all company databases that are accessed via 
the API Administration window.

To configure the API service:

1. Launch the Sage Master Builder API.

2. On the Sage Master Builder API Administration window, from 
the Edit menu, click Security.

3. On the Sage Master Builder API Security Settings window, select 
the Sage Master Builder objects to which you want to allow access.

4. Click Save Settings.

Notice that this setting merely enables access at the API service-level. 
That is, it does not override any security settings in Sage Master Builder 
itself. Any form-level, field-level, or user-level restrictions set there will 
still be in effect.

This configuration enables the selected objects at the API service. You 
must also activate SDK access at Sage Master Builder as described in the 
next section.

Notice that these instructions are provided to help you configure your 
system during development and testing. You cannot enforce any 
particular settings at your customer’s installation, but must inform the 
customer which settings are required.

Important:

While a Sage Master Builder customer is actively 
configuring the security settings for objects that can be 
accessed by the API, no requests can be processed by the 
API program.
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For complete information about configuring the API Service, see the 
Sage Master Builder SDK Developer Guide. For more information about 
joining the Sage Master Builder Developer Network Program, browse to 
this link
http://www.sagemasterbuilder.com/services/s_a_mbdn.asp 
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Enterprise Installation and Setup
This appendix provides information about the following:

• Installation and Setup Guidelines

• Installation Steps and Procedures
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Installation and Setup Guidelines

Pre-installation information

The Sage Master Builder program has two editions, Standard and 
Enterprise. Sage Master Builder Enterprise provides many features that 
are beneficial for customers with complex environments that may 
include remote connections, many simultaneous users, and/or multiple 
companies.

The product features of the Enterprise Edition are contained in your Sage 
Master Builder product license. When you activate your license and 
launch the License Administration Tool, you see in the Product or 
Feature column, Sage Master Builder - Ent. This indicates that your 
Enterprise Edition is licensed and activated. Evidence of your Enterprise 
Edition license also appears in the title of your product in view from 
Help > About Sage Master Builder. 

To run the Sage Master Builder program as the Enterprise Edition, two 
additional programs must be installed on the server. These programs are 
CodeBase Server for Sage Master Builder and CodeBase Administrator 
for Sage Master Builder. 

All editions of Sage Master Builder are installed with the License 
Administration Tool for Sage Software products. This program manages 
your product license attributes along with the Sage license server.

If you are an existing Enterprise Edition customer, then the CodeBase 
software is already installed and running on your server. During the 
installation process, you will not need to re-install the CodeBase 
software. If, however, you are a new Enterprise Edition customer, then 
you will be installing the two CodeBase programs along with your Sage 
Master Builder software. These two CodeBase programs are contained 
on a second CD containing only that software and no Sage Master 
Builder program software. Providing the CodeBase software on a 
separate CD provides the means for loading the programs on other 
computers on your network.

It is very important to install the programs and perform the installation 
tasks in a very specific order. In addition to the four main program 
installations, there are several intermediate tasks to complete before, 
during, and after the installation of the software. 
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We recommend that the following issues be taken into account for a 
smooth and successful installation experience:

Caution!
Sage Master Builder and/or its components do not run on 
or are not supported by some operating systems. Do not 
install Sage Master Builder to computers running these 
operating systems: 
• Windows 95
• Windows 98
• Windows NT Server
• Windows NT Workstation

Caution!
For current Sage Master Builders customers: When you 
reinstall or upgrade, turn off scheduled reports. Reports 
must not be printed, faxed, or emailed at the same time as 
your re-install or upgrade. 

Caution!
For current Sage Master Builder customers: Do not 
upgrade or reinstall Sage Master Builder while the Sage 
Master Builder API is running.
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Duration of the installation process

Plan on at least 10 and possibly up to 20 minutes per computer to install 
Sage Master Builder and its companion software, such as the Sample 
Company and the License Administration Tool. The duration of the Sage 
Master Builder installation depends a great deal upon each computer’s 
configuration. For example, some newer computers are pre-installed 
with essential software required to run Sage Master Builder software 
such as the .NET Framework and the Windows Installer 3.1. Installation 
to some older computer may take more time.

Other required software

Both Windows Installer 3.1 and the Microsoft .NET Framework 2.0 must 
be installed on all computers running Sage Master Builder software. 
First, the installer determines if the .NET Framework 2.0 and the 
Windows Installer 3.1 are already installed. If not, the installer installs 
the required software automatically. 

Important: 

• Customer Support recommends that you complete all 
installations and configuration of the server before you 
begin installing Sage Master Builder to the client 
computers. 

• The programs, CodeBase Administrator for Sage 
Master Builder and CodeBase Server for Sage Master 
Builder, are now located on a separate Enterprise 
installation CD. 

• Existing Sage Master Builder customers: Before you 
install, make a backup copy of your existing company 
data. 

• Before installing Sage Master Builder software, shut 
down all other programs except firewall or antivirus 
software. 

• You must have administrator rights on the network and 
administrator rights on each computer to install Sage 
Master Builder software. Administrators have full 
control over computers for installing software. 

• When installing the software, log on to Sage Master 
Builder as the supervisor. 
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Plan for an additional 10 to 15 minutes per computer to install .NET 
Framework 2.0 and Windows Installer 3.1 on each computer. 

Product CDs

You need the product CD to install the Sage Master Builder Enterprise 
software. You will also the product CD to install the CodeBase Server 
and Administration software. 

Installation and Internet connectivity

Internet access is not required when you install Sage Master Builder.

Installation environments, operating systems, and services

It is very important that you understand the network environments and 
operating systems on the computers and server computers where you 
install Sage Master Builder software. For more information, see Chapter 
2, System Requirements and Configuration.

Installation options

When you load the Sage Master Builder CD into your CD drive, the 
Welcome to Sage Master Builder Installation window opens. You are 
presented with two options. 

• This computer will be my Sage license server. Choose this option 
to install the Sage license server on the computer that is your 
network server. You only need to install this option one time on your 
network. This is the computer on which you activate your license.

Important: 

If you need to install Windows Installer 3.1, then the 
computer must restart before you continue with the Sage 
Master Builder installation. After your computer restarts, 
opening and closing your CD drawer with the installation CD 
in it should restart the Sage Master Builder installation. If 
the install program does not start automatically, go to 
Start > Run > Browse, locate your CD drive and select 
SageMasterBuilder.exe. Then click OK. 
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• This computer will run Sage Master Builder only. You may install 
Sage Master Builder on as many computers as you like. Following 
each Sage Master Builder installation, you must specify the 
computer on your network that is the Sage license server.

Installing the Sample Company

The Sample Company is pre-selected to be installed with all Sage Master 
Builder software installations. We recommend that you install the 
Sample Company because it provides an example of realistic company 
data being used in Sage Master Builder. It is also used extensively in 
Sage Master Builder training classes.

 

Installation Steps and Procedures

Installation steps overview

Following are the 14 steps that take you through the Master Builder 
Enterprise Edition installation. They involve many different procedures, 
some of which appear within the step itself and some of which appear in 
Sage Master Builder Help. 

Step 2 installs the Sage license server. In addition, it also installs Sage 
Master Builder. Some of the subsequent steps involve following 
procedures that are part of the Sage Master Builder in-product Help 
system. These procedures are identified for you so that you can locate 
them in the Sage Master Builder Help system. 

The name of the topic is provided as well as a Help search shortcut. 

To locate the Help topic needed for this installation process:

1. Launch Sage Master Builder, and from the menu bar, click Help > 
Contents and Index. 

2. In the left pane of the Help viewer window, click the Search tab. 

Important: 

Installing the Sample Company overwrites any previous 
installations of the Sample Company. 
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3. Copy and paste, or type the Help search shortcut in to the text box 
and click List Topics. 

The Help viewer lists the topic

4. Click the topic title in the list. 

The Help topic opens in the right pane of the Help viewer window. 
From here you can print the topic, or you can read and follow it 
on-screen. 

Step 1 - Configure your server

Before you begin to install any programs, make sure your server 
hardware meets the system requirements and that you have configured it 
to run Sage Master Builder Enterprise. 

Step 2 - Install Sage license server to the server

For detailed instructions about install Sage license server, see page 31, 
“Installing the Sage license server” in this guide. 

Important: 

• Your server must have a fixed or permanent IP Address. 
This requires manual configuration of the server.

• We cannot recommend specific server configuration. This 
must be determined by your system administrator. 

Important: 

• Sage Master Builder Enterprise software, CodeBase 
Server for Sage Master Builder software, and 
CodeBase Administrator for Sage Master Builder 
software must be installed on the same drive of the 
same computer (the server). 

• Write down your administrator user password and keep 
it in a safe place. 

• Write down the name and IP Address of the Sage 
license server computer. You will need to refer to these 
later. 
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Step 3 - Log on to the License Administration Tool

Launch the License Administration Tool, set your administrator user 
password and log on as the Administrator. 

Logging on as the Administrator allows you to enter your product keys 
and activate your product license. For detailed instructions, see pages 39 
to 41 in the Sage Master Builder Installation and License Administration 
Guide. 

Step 4 - Activate your product license

Using the License Administration Tool, activate your product license on 
the server. For detailed instructions, see pages 45 to 47 in this guide. 

Step 5 - In Sage Master Builder, rebuild the indexes on any 
existing databases

Rebuilding the databases is performed from the 7-4 Rebuild Indexes 
window in Sage Master Builder. The topic name is “Indexing the 
database.”

Step 6 - Add all companies to the Server Company List

In Sage Master Builder using the 7-8 Server Company List window, 
add all your companies to the Company Server List. The topic name is 
“Adding companies to the 7-8 Server Company List.” 

Step 7 - Install CodeBase Server for Sage Master Builder to 
the server

 

Note: 

If this is a first-time installation, you can skip this step.

Caution!
The CodeBase Server for Sage Master Builder software must 
be installed on the same hard disk drive as the Sage Master 
Builder Enterprise software.
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Install the program from the CodeBase CD, which contains the both 
CodeBase programs, CodeBase Server for Sage Master Builder and 
CodeBase Administrator for Sage Master Builder. 

To install CodeBase Server for Sage Master Builder on the server:

1. Insert the CodeBase software CD into your CD-ROM drive.

2. Autorun launches the installation menu.

3. Select Install CodeBase Server for Sage Master Builder, and 
follow the instructions. 

Step 8 - Install CodeBase Administrator for Sage Master 
Builder to the server

Install the program from the Enterprise installation CD, which contains 
two programs, CodeBase Server for Sage Master Builder and CodeBase 
Administrator for Sage Master Builder. 

To install CodeBase Administrator for Sage Master Builder on 
the server:

1. Insert the CodeBase software CD into your CD-ROM drive.

2. Autorun launches the installation menu.

3. Select CodeBase Administrator for Sage Master Builder, and 
follow the instructions. 

More Help topics about this general subject are located in Sage Master 
Builder Help, “Appendix I - Enterprise Installation and Setup” and 
provide more information. 

Important: 

• CodeBase Server for Sage Master Builder is installed as a 
service, but it must be started manually. Click the desktop 
icon to start the service.

• You may be required to restart the server after installing 
CodeBase Server for Sage Master Builder.
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Step 9 - Launch CodeBase Server and then launch CodeBase 
Administrator and finally connect to the server for the 
first time

To connect to the server for the first time:

1. Launch CodeBase Administrator for Sage Master Builder. 

2. From the File menu, select Connect.

3. In the Server Name text box, enter localhost.

4. In the Account Id text box, enter ADMIN.

No password is necessary when connecting to the server from 
CodeBase Administrator for Sage Master Builder for ADMIN 
account.

5. Click Connect. 

More Help topics about this general subject are located in Sage Master 
Builder Help, “Appendix I - Enterprise Installation and Setup” and 
provide more information. 

Step 10 - Confirm and/or change your settings through Server 
Settings

Confirming and/or changing your setting through Server Settings is done 
using the CodeBase Administrator window. The procedure for doing it in 
is the Help topic “Configuring the Server Settings for CodeBase 
Administrator.”

Step 11 - Set up user accounts through Account Management

Confirming and/or changing your setting through Server Settings is done 
using the CodeBase Administrator window. The procedure for doing it in 
is the Help topic “Adding new accounts.”

Important: 

• The procedure for connecting to CodeBase Administrator 
for Sage Master Builder for the first time is different from 
connecting to it on subsequent occasions.

• Confirm that your Password and Port ID are correct.
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Step 12 - Install Sage Master Builder to each client

Install Sage Master Builder to each client workstation. For detailed 
instructions about install Sage license server, see page 34, “Installing 
Sage Master Builder” in this guide. 

Step 13 - Specify the Sage license server from each client 
workstation

From each client workstation, launch Sage Master Builder and specify 
the Sage license Server. 

For detailed instructions about install Sage license server, see pages 54 to 
57, “Specify Sage License Server” and pages 58 - 61 “Running Sage 
Master Builder Connected” in this guide. 

Step 14 - Set up and configure CodeBase Server connections 
for each client

In Sage Master Builder using a File menu command. The topic name is 
“Configuring CodeBase Server connections for new clients.” 

Important: 

Before installing to the Clients, you must set up each user in 
Account Manager. 

Note: 

Before you can run Sage Master Builder on client 
workstations, you have to specify the computer on your 
network that is the Sage license server. 
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Glossary definitions

This glossary provides definitions of key terms used in Sage Master 
Builder and License Administration Tool.

administrator user

When you log on the License Administration Tool as the Administrator, 
you have access rights to all the License Administration Tool functions. 
These functions include product license management functions such as 
activating, adding, and updating. They also include managing license 
groups, license use, and license reservations.

If you are not the Administrator, you can launch the License 
Administration Tool window and log on as Other (View only) and 
review information it. Only the Administrator; however, has the rights 
to use the window to manage licenses. 

Important: 

To use the license management functions available with 
the License Administration Tool, the Windows user must 
have administrator rights on the computer running the 
License Administration Tool software. Computer 
administrators are members of the Administrators group 
and have full control over the computer, such as installing 
software and full access to other user accounts.
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administrator password

Before logging in to the License Administration Tool the first time as the 
Administrator, you must set and enter the administrator password using 
the Logon Administrator Password window.

API

API is an acronym for application programming interface. Sage 
Master Builder delivers an API with its software package. The API 
defines the complete methods by which programmers can access 
and control Sage Master Builder to build programs that integrate 
with Sage Master Builder and extent its capabilities.

Programmers interested in developing APIs are invited to join the 
Developer Network Program. For information, browse to this link:
http://www.sagemasterbuilder.com/services/s_a_mbdn.asp 

To review existing APIs that have been developed for Sage Master 
Builder, browse to this link: 
http://www.sagemasterbuilder.com/products/p_a_overview.asp 

client workstation computer 

Computer connected by a network to the Sage license server. Client 
workstations run Sage Master Builder.

company folder

A folder that contains all database information for a Sage Master Builder 
company. The company folders are located under the \MB7 folder, which 
is accessible via Windows Explorer.

computer name

The name by which the local area network identifies a server or 
workstation. Each computer name on the network is unique.

Important:

We recommend that you write your Administrator password 
down and keep it in a convenient place. If you forget it, it 
can only be re-established through contact with Customer 
Support at 800-866-8049.
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If you have activated floating use licenses, the Current users of the 
product or feature grid on the License Administration Tool window 
displays the computer names for the users that are currently using the 
selected product or feature.

exclusive access

While users in a network environment can simultaneously work in the 
same company folder to access company data, some operations require 
“exclusive access” or access by a single user to protect the data. 
Exclusive access is extremely important, for example, when rebuilding 
indexes or closing the accounting at the fiscal year-end.

firewall

A firewall is a device and/or software program that guards the entrance 
to a private network and keeps out unauthorized or unwanted traffic. The 
integrity of this protective barrier depends on the effective deployment, 
configuration, and capabilities of individual firewall devices.

When you install programs on a computer that is running a firewall, you 
see alert messages from the firewall about allowing the new program to 
access the Internet, to access privileged resources, and/or to act as a 
server. It is best to grant access to new programs that you are installing, 
such as Sage Software License Administration Tool and Sage Master 
Builder. 

hardware failure (of the computer running the Sage license 
server)

A hardware problem can cause the computer running the Sage license 
server to fail. If that happens, you have to re-install the Sage license 
server on a different computer on your network and re-activate your 
product license. Then you have to go to each computer running Sage 
Master Builder and from there specify the new computer on which you 
have installed the Sage license server.

IP address

Every computer connected to the Internet is assigned a unique number 
known as an Internet Protocol (IP) address. This numeric address of a 
computer on the Internet is written as a set of four numbers separated by 
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periods (each number can range from 0 to 255). An example of an IP 
address is 123.123.4.5. 

License Administration Tool for Sage Software Products

The License Administration Tool for Sage Software allows you to view 
and to manage your Sage Master Builder product. Using the License 
Administration Tool, you can import license files, activate licenses, 
reserve the use of products and features, and monitor the use of products 
and features. This tool supports site licenses and floating use licenses.

License Administration Tool - Available Uses column

Indicates of the number of uses for a product or feature that are 
available to users.

The Available Uses column on the License Administration Tool 
window indicates the uses available for all users.

If you reserved the use of products and features for a floating use 
license, the Available column in the Summary of product or 
feature use grid displays the available uses for each group and the 
available uses that are unreserved.

License Administration Tool - Product or Feature column

The Product or Feature column on the License Administration 
Tool window lists the names of the products and features for which 
you have or had a license. 

License Administration Tool - Product or Feature use

Product or feature use indicates the number of people who can use 
a product or feature simultaneously. The Total Uses column on the 
License Administration Tool window displays this information.

For floating use licenses that support reservations, the Summary 
of product or feature use grid displays in the License 
Administration Tool window.

You can have both reserved and unreserved uses.
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License Administration Tool - Product line

The Product Line column on the License Administrator Tool 
window lists the Sage Software product line for which you have 
permission to view the licensing information. For example, Sage 
Timberline Office and Sage Master Builder are product lines.

License Administration Tool - Reservations allowed

Some floating use licenses allow you to reserve product or feature 
uses for individual users and groups. Site licenses, however, do not 
allow reservations.

If a license for a product or feature allows reservations, the 
Reservations Allowed box is selected.

License Administration Tool - Reserved

Indicates that you have assigned uses of a product or feature to a group.

For floating use licenses that support reservations, the Summary of 
product or feature use grid in the License Administration Tool 
window displays the number of reserved and unreserved uses for the 
selected product. 

Note: 

This column is hidden by default. To display it, right-click a 
column heading in the grid and select Hide/Show Columns 
> Product Line.

Note: 

This column is hidden by default. To display it, right-click a 
column heading in the grid and select Hide/Show Columns 
> Reservations Allowed.

Note: 

Group reservations are available only for some floating use 
licenses. They are not available for site licenses.
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When a user logs in to a Sage Software product or feature, the Sage 
license server assigns the user to the first available group to which the 
user belongs. That is, it reserves the use of that product or feature for the 
individual.

License Administration Tool - Reserved for

For floating use licenses that support reservations, the Summary of 
product or feature use grid in the License Administration Tool 
window displays the names of the groups for the selected product or 
feature in the Reserved For column. If you have not reserved all the 
uses, the Reserved For column displays unreserved uses as well.

License Administration Tool - Reserved under

For floating use licenses that support reservations, the Summary of 
product or feature use grid in the License Administration Tool 
window displays the names of the groups for the selected product or 
feature in the Reserved Under column. 

If you have not reserved all the uses or if the license does not support 
group reservations, the Reserved Under column displays unreserved 
uses.

License Administration Tool - Status column

The Status column on the License Administration Tool window lists 
the statuses of the licenses. The license statuses are Not Activated, 
Activated, and Expired.

Note: 

Group reservations are available only for some floating use 
licenses. They are not available for site licenses.

Note: 

The Current users of the product or feature grid displays 
only after you activate floating use licenses. It does not 
display for site licenses.
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License Administration Tool - Total Uses column

Indicates the number of people who can use a product or feature 
simultaneously. 

The Total Uses column on the License Administration Tool window 
indicates all the uses, whether in use or available, for a product or 
feature.

If you reserved the use of products and features for a floating use license, 
the Total column in the Summary of product or feature use grid 
displays the total number of uses for a product or feature by group and 
the total number of uses in the pool of unreserved uses.

License Administration Tool - Unreserved

Indicates that you have not assigned all the uses of a product or feature to 
a group.

For floating use licenses that support reservations, the Summary of 
product or feature use grid in the License Administration Tool window 
displays the number of reserved and unreserved uses for the selected 
product. 

When a user logs in to a Sage Software product or feature, the Sage 
license server assigns the user to the first available group to which the 
user belongs. If no group reservations are available, the Sage license 
server grants the user a reservation from the pool of unreserved uses. 
That is, it reserves the use of that product or feature for the individual.

License Administration Tool - User name

The name that an individual uses to log in to a Sage Software product or 
feature.

If you have activated floating use licenses, the Current users of the 
product or feature grid on the License Administration Tool window 
displays the user names for the people that are currently using the 
selected product or feature.

License Administration Tool - Version

The number that identifies the release of the selected Sage Software 
product or feature.
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For the Sage Master Builder product line, the Version column on the 
License Administration Tool window displays All. This indicates that 
you have a license for all versions of the selected product or feature.

For example, for the Sage Master Builder product line, All indicates that 
you can use Sage Master Builder 12 and later.

license

A legal authorization from Sage Software to use the product or feature.

Sage Software grants floating use licenses and site licenses. Some 
floating use licenses allow reservations.

License Types include Floating Use and Site.

License Statuses include Activated, Not Activated, and Expired.

A license expires if: 

• It has not been activated within the grace period.

• It has been activated, and the license agreement states that it 
expires. 

Refer to the end-user license agreement for details about the terms 
and conditions of your license.

license - expiration date

The date on which the Sage Software product or feature stops 
functioning. 

If applicable, the Expiration Date column on the License 
Administration Tool window lists the date that the license for a product 
or feature expires. The license for a product or feature has an expiration 
date if one of the following statements is true:

• You have not activated the license within the grace period.

• You have activated the license, and the license agreement states 
that the activation is for a limited time. 

Otherwise, the license does not expire and the Expiration Date is None.
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license - floating use

A floating use license restricts the number of simultaneous users of a 
product or feature. Each person must obtain a use for a product or feature 
from a finite set of uses. 

When a user logs in to a Sage Software product or feature, the Sage 
license server determines whether a use is available on your network. If 
so, it assigns a floating use to the person.

You can reserve some floating use licenses for individual users and 
groups.

license - grace period

The period of time that between installing the product and activating the 
license. 

For the grace period to take effect, the License Administration Tool must 
be installed and the product keys added or updated, but your license is 
not yet activated. The grace period for Sage Master Builder lasts seven 
days. 

license - in use

Indicates of the number of people that are using a product or feature.

The In Use column on the License Administration Tool window 
indicates all users who are using a product or feature.

If you reserved the use of products and features for a floating use license, 
the In Use column in the Summary of product or feature use grid 
displays the number of users who are using a product or feature in each 
group and the number of users with a use from the pool of unreserved 
uses.

license - in use since

If you have activated floating use licenses, the Current users of the 
product or feature grid on the License Administration Tool window 
displays the date and time that the user logged in to the product or 
selected the add-in feature
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license - product

A product license defines your Sage Master Builder product attributes. 
For example, your license number contains information about your 
version of Sage Master Builder, any Add-on modules, and the number of 
license uses that you have purchased.

license - reserved

A license use that has been assigned to a specific license group in the 
License Administration Tool window and defined in the Sage Master 
Builder 7-3-2 User List window. 

When you log in to a Sage Master Builder company, the Sage license 
server first checks reserved licenses in the license group to which you 
belong. If no more license uses are available from that license group, you 
may be assigned an unreserved license use if one is available. 

In Sage Master Builder, supervisor users can acquire any license use, 
reserved or unreserved, that is not currently in use. 

license - site

A site license allows an unlimited number of people on the same network 
to use a product. Site licenses do not require reservations. An example of 
a site license product is the Sage Master Builder estimating module 
license.

license - unreserved

A license use that has not been assigned to a license group or user. 

If no more reserved license uses are available from the license group to 
which you belong, then the Sage license server assigns you an 
unreserved license use, if one is available.

license status - activated

An Activated status for a license indicates that you can use this Sage 
Software product or feature, such as Sage Master Builder. 

After adding or updating a license, you must activate it. Activation 
verifies that the Sage Software product or feature is a legal copy and is 
installed in compliance with the end-user license agreement.
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license status - expired

An Expired status for a license indicates that you can no longer use the 
product or feature. The product or feature stops functioning on the 
expiration date. A license expires if one of the following statements is 
true:

• You do not activate the license during the grace period.

• You activated the license, and the license agreement states that 
activation is for a limited time. 

license status - Not Activated

A Not Activated status for a license indicates that you added or updated 
a license but have not activated it. For a short grace period, you can use a 
product without activating it. The grace period for Sage Master Builder 
license is seven days. 

license use

License uses define the number of people who can work in Sage Master 
Builder on your company network simultaneously. For example, let’s 
suppose that you have purchased 10 license uses with your product 
license. With 10 license uses, 10 people can be logged in to Sage Master 
Builder at the same time through your network. 

Even if you install Sage Master Builder on, for example, 50 computers, 
the Sage license server will only assign 10 license uses at the same time. 
If you are the eleventh person who tries to log on to Sage Master Builder, 
you will see a message telling you that no license uses are available and 
to try again later. 

You can manage your license use reservations through the License 
Administration Tool window. 

license use - acquired

There are several preconditions for acquiring a license use. 

• Your product license has been activated.

• A network connection exists between the computer running the 
Sage license server software and your workstation computer 
running Sage Master Builder.
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• You have specified the Sage license server computer on your 
network from your computer running Sage Master Builder.

• You have access to and rights in a Sage Master Builder company.

• A license use is available. 

When you can launch Sage Master Builder and log in to a Sage Master 
Builder company, you have acquired a reserved license use from a 
license group or an unreserved license use. 

When you exit a Sage Master Builder company or the Sage Master 
Builder program, the license use is returned to the license group or the 
unreserved license uses. If you switch between two Sage Master Builder 
companies, your license use is returned, then re-acquired. 

license use - returned

When you exit a Sage Master Builder company or the Sage Master 
Builder program, the license use is returned to the license group or the 
unreserved license uses. If you switch between two Sage Master Builder 
companies, your license use is returned, then re-acquired. 

If you experience a computer or network failure, Sage Master Builder 
does not have a chance to return your license use as usual. After a certain 
period of time, your license use is automatically returned to the license 
group or the unreserved license uses. 

local area network (LAN)

When two or more computers are connected and communicating with 
each other, and they are in close proximity, then you are operating in a 
local area network (LAN) environment. 

Sage Master Builder is engineered to run in a LAN environment or a 
stand-alone environment. 

(dot) .NET Framework 

The Microsoft .NET Framework is a platform for building, deploying, 
and running Web Services and applications. It is required to be installed 
on computers running Sage Master Builder. During Sage Master Builder 
installation, if the .NET Framework 2.0 is not found, it will be installed 
automatically. 
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network

A group of computers connected by a telecommunications link that 
allows them to share information. A network may be wired or it may 
be wireless. Two types of networks are local area network (LAN) and 
large area network (WAN). The Internet is a WAN. 

product

The Estimating add-on module is a Sage Master Builder product. 

product key

Letters and numbers that identify the license for a product or feature. Part 
of the license activation process involves entering your product key or 
keys into text boxes in the License Administration Tool. 

Sage license server

The computer in your network that manages the licenses for Sage Master 
Builder. It becomes the Sage license server when the License 
Administration Tool software is installed on it, and you import the 
license file or enter your product keys. In a network environment, the 
computer running the Sage Master Builder must be connected to the 
computer running the Sage license server.

Sage License Server Connection State - connected

Sage Master Builder has been engineered to run connected to the 
computer on your network that is the Sage license server. The Sage 
license server stores information about your product license. 

For example, it stores license activation status, type of license, add-on 
module licenses, and number of users allowed to use the Sage Master 
Builder program simultaneously. When your client workstation computer 
is connected to the Sage license server software, then the Sage Master 
Builder program runs connected. 

Sage License Server State - disconnected

If the conditions for running Sage Master Builder connected are not met, 
you can run the program disconnected. While you are disconnected, you 
can only open a Sage Master Builder company with exclusive access. 
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You are not connected to the company data stored on the server when 
you are working in a network environment. 

For example, you have been running Sage Master Builder connected, but 
you lose your network connection. When you launch and run Sage 
Master Builder the next time, your computer cannot communicate with 
the Sage License server computer. An alert message window displays the 
message Unable to connect to the Sage license server. You have 9 
more uses before you must reconnect. 

If you don’t see the “unable to connect” message at a subsequent launch 
of Sage Master Builder, you know that your connection with the Sage 
license server has been re-established. 

Each time you launch Sage Master Builder and acquire a license use, the 
clock for running Sage Master Builder disconnected resets to 9 more 
times with this current launch representing the 10th time. 

If you launch Sage Master Builder 10 times without a connection to the 
computer running the Sage license server, then Sage Master Builder 
becomes locked. The only available option at that point is to launch Sage 
Master Builder, click File > Specify Sage License Server, and follow 
the instructions for specifying and reconnecting to the Sage license 
server.

server 

There are many kinds of servers. Some servers are denoted by their 
hardware configuration and a specialized operating system. Other servers 
consist of specialized software applications running on standard 
computers. 

Some servers are called file server computers and may be dedicated to 
storing files and data. For example, Sage Master Builder company data 
can be stored on a file server computer. Any Sage Master Builder user on 
the same network as the file server computer can access and store data 
there. 

A server can also be a software application that provides a specific kind 
of service to client software running on other computers. The term can 
refer to a particular piece of software, such as the Sage License Server 
software. A single computer may have several different server software 
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applications running on it, thus providing many different servers to client 
workstations running on a network.

Session ID

A unique number that indicates a remote connection for this user name 
and computer name. Each remote connection requires a use of the 
product or feature. 

If you have activated floating use licenses, the Current users of the 
product or feature grid on the License Administration Tool window 
displays the session IDs for the users that are currently using the selected 
product or feature. 

For example, if a user logs in to a Sage Software product through 
Windows Terminal Services, a Session ID displays for that user.

stand-alone environment 

A stand-alone environment implies that you are running the Sage license 
server and Sage Master Builder on a single computer. No other 
computers running Sage Master Builder are connected to the Sage 
license server computer via a network. 

supervisor user

When you log in to a Sage Master Builder company as the supervisor 
user, you have access to the entire program. The following is a list of 
actions you can only perform when logged in to the program as supervi-
sor:

• Create security groups.

• Grant access-rights to security groups for windows and items within 
windows such as text boxes, lists, and grid columns.

• Create user names and passwords, and assign user names to security 
groups.

• Create new companies.

• Convert data for use in Sage Master Builder.

• Make and save changes to the General Ledger Setup.

• Close the accounting at the fiscal year-end.
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• Close payroll at the calendar year-end.

• Restrict posting to specific posting periods in various accounting 
processes.

• Create new companies

Terminal Services

Windows Terminal Services is a component of Microsoft Windows 
Server. Terminal Services consists of a terminal server and one or more 
remote workstations. It allows users to access programs or data stored on 
a remote computer by a phone, network, Internet connection, or other 
communication methods.

Remote network connections do not provide adequate bandwidth to run 
Sage Software products without the use of Terminal Services. Terminal 
Services provides remote users with a stable and well-performing 
experience with Sage Software products.

user name

User name is the name with which you log in to a Sage Software product 
such as Master Builder. If you have activated floating use licenses, the 
Current users of the product or feature grid on the License 
Administration Tool window displays the user names for the people that 
are currently using the selected product or feature.

In the License Administration Tool, the key user name Administrator 
user. Only the Administrator user has special rights to manage the 
product license using the License Administration Tool window. 

User names define access to Sage Master Builder companies and have to 
be established in a Sage Master Builder company by a supervisor user. 
Every time you create a new company, you have to create a list of user 
names on the 7-3-2 User List window.

wide area network (WAN)

A WAN is a computer network that spans a relatively large geographical 
area. Typically, a WAN consists of two or more local-area networks 
(LANs). Computers connected to a wide-area network are often 
connected through public networks, such as the telephone system and 
with the security of virtual private networks (VPN). 
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For information about running Sage Master Builder in a WAN, contact 
your Business Partner or Sage Certified Consultant. 
131



Glossary
132



Index
Symbols
.NET

about 21
client requirements 24
server requirements 23

.NET Framework
definition 122

A
administrator password

about 51
definition 112
re-set forgotten 53

administrator user 51
definition 111

Adobe Reader
auto-update 28
disengage auto-update 28
version recommendation 27

Adobe Reader 7
faxing 27

Adobe Reader 8
faxing 27

API
about 38, 88
Administration window 90
configure service 94
definition 112
installation 89
launch 92
start API service 92
states 93
system requirements 29, 90

Available Uses column 114

B
backup

data 16
Business Partners

about 13

C
Citrix servers

DOS cmd installation 85
client

network configuration 20
workstation 112

client requirements
.NET 24

CodeBase Server
Windows Vista 78

column
about 56
hide 56
hide all 57
show 56

company
folder 112

computer
name 113
workstation 112

computer name
determine 67

configure
Windows 2000 Pro

date format 82
Windows 2000 Server

date format 82
Windows Server 2003
133



Index
date format 81
printers 81

Windows XP
date format 82

connection state
view 72

customer support
contact 10
FAQ 11

D
data

backup 16
date format

Windows 2000 Pro 82
Windows 2000 Server 82
Windows Server 2003 81
Windows XP 82

disk-write caching
disable Windows 2000 83

documentation
install 90

DOS cmd installation
Citrix servers 85
Terminal servers 85

E
environment

LAN 122
exclusive access 113

F
FAQ

customer support 11
Fax modem

use with Sage Master Builder 26
faxing

Adobe Reader 8 27
operating systems 26

firewall
about third-party about 37
definition 113

G
group reservations

about 59
set up 60

guides
API Object Reference 9
Getting Started Product Overview 9
Getting Started Sage Master Builder 

and Your Business 8
Installation and License 

Administration 6
printing

printing
guides 10

SDK Developer 9
User 8

H
hardware failure

Sage license server 113

I
implementation 32

business 32
install

.NET framework 22
component

documentation 90
samples 90
test programs 90

overview 32, 98
upgrade 44

installation 32
before beginning 6
different configurations 38
re-installation 48
Sage license server 39
Sage Master Builder 42
Step 13 109
Step 14 109

Internet Explorer 6.0
(SP1) verify 24
134



Index
IP Address
definition 68, 75, 114
determine 67

L
LAN

environment 122
license

definition 118
expiration date 118
floating use 119
in use 119
in use since 119
product 120
reserved 120
unreserved 120

License Administration Tool
about 50
Available Uses column 114
definition 114
Product Line 115
Product or Feature column 114
Product or Feature use 114
Reservations allowed 115
Reserved 115
Reserved for 116
Reserved under 116
Status column 117
Total Uses column 117
Unreserved 117
User name 117
Version 118

license file
import 57

License Server state
connected 123
disconnected 123

license status
activated 120
expired 121
grace period 119
not activated 121

license use 121
acquired 121
returned 122

N
network

definition 123
disconnected 61
disconnected drive 63
local area 122
unplugged 62
WAN 126
wide area 126

network configuration
client and workstation 20
server 20

O
operating systems

faxing 26
Windows Vista 78

P
printers

Windows Server 2003 81
product

definition 123
product key

add 58
definition 123
update 58

Product or Feature column 114
Product or Feature use 114

R
release notes 8
reports

faxing and emailing
setup 26

requirements
web browser 20

Reservations allowed 115
135



Index
Reserved 115
Reserved for 116
Reserved under 116

S
Sage Certified Consultant

about 13
Sage license server

about 66
connection state 72
definition 123
hardware failure 113
install location 35
IP Address 66
name 66
select 66
what? 50
where? 50
why? 50

Sage Master Builder
connected 69
install location 35

Sample Company
install 37

samples
install 90

server
computer 124
definition 68
network configuration 20
software application 124
Terminal 84

server requirements
.NET 23

session ID
definition 125

special configuration
Vista 80
Windows Vista 78, 79, 80

stand-alone
definition 125

states
API program 93

Status column 117
supervisor user

definition 125
system information

viewing 22
system requirements

API 29, 90
client hardware 17
file server hardware 16
operating system 18
server hardware 17
workstation hardware 17

System Verification Tool
about 16

T
Terminal servers

DOS cmd installation 85
Terminal Services

definition 126
test programs

install 90
Total uses column 117
training

classes overview 11
getting started 12
options 11

troubleshooting
network 61, 62, 63

U
unidentified publisher

Windows Vista 80
Unreserved 117
upgrade

install 44
installation 46
post-installation 47

User name 117
user name 126
136



Index
V
v13

welcome 2
Version 118
Vista

special configuration 80
unidentified publisher 80

W
WAN

network 126
web browser

requirements 20
Windows 2000

verify SP4 23
Windows Installer 3.1

verify 25
Windows Vista

CodeBase Server 78
Sage license server

Sage license server
Windows Vista 79

Sage Service Host
Sage licensing

Windows Vista 80
Service Host installation 80
sleep mode 79
special configuration 78, 79, 80

WMI
client

verify 25
workstation

client 112
computer 112
network configuration 20
137



Index
138


	Welcome to Sage Master Builder Installation
	Installation Overview
	Welcome to Sage Master Builder version 13 installation
	Program Enhancements
	What’s new in the latest release

	Read This Before You Install
	Where do I begin?
	What information is in this book?


	Printed and Printable Documentation
	Sage Master Builder Release Notes
	Sage Master Builder User Guide
	Getting Started: Sage Master Builder and Your Business
	Getting Started: Product Overview
	Sage Master Builder SDK Developer Guide
	Sage Master Builder API Object Reference Guide
	Printing Sage Master Builder printable documentation

	Customer Support Resources
	Contacting Customer Support
	Frequently Asked Questions
	About the Remote Assist Tool
	Training Resources
	Training options
	Overview of customer classes
	Getting started with training

	Business Partners and Sage Certified Consultants
	About Business Partners and Sage Certified Consultants



	System Requirements and Configuration
	Hardware Requirements
	About system requirements and configuration
	About the Sage System Verification utility
	Server hardware specifications
	Data backup
	Server hardware requirements
	Client and workstation hardware requirements

	Operating System Requirements
	Operating systems
	Web browser requirements

	Network Configuration Requirements
	Server network configuration
	Client and workstation network configuration

	Microsoft .NET Framework 2.0 Requirements
	About installation and Microsoft .NET Framework
	About installing .NET Framework 2.0 and Operating Systems
	Viewing and verifying system information
	.NET Framework Requirements for Server Computers
	Minimum requirements for the .NET Framework 2.0 on servers
	Verifying that Windows 2000 Service Pack 4 is installed

	.NET Framework Requirements for Client Computers
	Minimum requirements for the .NET Framework 2.0 on clients
	Verifying that Microsoft Internet Explorer 6.0 Service Pack 1 is installed
	Verifying that Microsoft Windows Installer 3.1 is installed
	Verifying that Windows Management Instrumentation (WMI) is installed


	Report Scheduling and Faxing Functionality
	About setting up emailing and faxing through Sage Master Builder

	Sage Master Builder API
	System requirements for Sage Master Builder API


	Sage Master Builder Installation
	Installation Preview
	Business implementation considerations and installation
	Pre-installation information
	Recommended installation locations
	Other Installations Options and Considerations
	About installation and third-party firewalls
	Installing the Sample Company
	Installing the Sage Master Builder API


	Program Installation to Different Configurations
	About installing the Sage Master Builder software to different configurations

	New Installations
	Installing the Sage license server
	Installing Sage Master Builder

	Upgrade Installations
	About upgrading Sage Master Builder
	Upgrade pre-installation tasks
	Installing the upgrade to either the Sage license server or client workstation
	Upgrade post-installation tasks
	About re-installing and changing the computer designation


	Managing Your License with the License Administration Tool
	License Administration Tool
	About the License Administration Tool for Sage Master Builder

	Administrator User and Administration Password
	About the administrator user and administrator password
	Setting the Administrator password
	Changing the Administrator password
	Re-setting a forgotten administrator password

	Monitoring Product and Feature Use
	About monitoring product and feature use
	Show and Hide Column Features
	About showing or hiding columns
	Showing columns
	Hiding columns
	Hiding all columns


	Managing Licenses
	About managing licenses
	Importing the license file
	Adding or updating product keys
	Activating licenses

	Managing Reservations
	About managing group reservations
	Setting up group reservations
	Removing group reservations

	Troubleshooting Network Disconnection Issues
	Disconnected from the network
	Network cable unplugged
	Disconnected network drive


	License Use and Sage Master Builder
	Specify Sage License Server
	About specifying the Sage License Server
	Selecting the Sage license server computer
	Entering the IP Address or name of the computer
	Determining the name of a computer
	Determining the IP Address of a computer
	What is an IP Address?
	What is a server?

	Running Sage Master Builder Connected
	Launching and running Sage Master Builder connected
	About the Sage License Server Connection states
	Viewing the Sage license server connection state
	Company List window
	About the Company List window
	Mapping a network drive to access a company



	Special Configuration
	Windows Vista Business Operating System
	Launching Sage Master Builder to run as administrator for scheduling reports
	Vista and CodeBase Server
	Running the Sage license server on Vista
	Vista sleep mode prevents computers from obtaining a license use
	Sage licensing cannot auto-start on Vista
	Sage licensing not installed to Vista over network
	Vista displays “Unidentified Publisher” message

	Windows Server 2003 Operating System
	Configuring Windows Server 2003 date format
	Setting up Windows Server 2003 for PDF and RTF printers

	Windows XP Professional (SP2) Operating System
	Configuring the Windows XP Professional date format

	Windows Server 2000 (SP3) Operating System
	Configuring Windows Server 2000 Server (SP3) date format

	Windows 2000 Professional (SP4 or newer) Operating System
	Configuring the Windows 2000 Professional date format
	Disabling disk-write caching for Windows 2000 Professional (SP4 or newer) workstations

	Citrix and Terminal Servers
	Using Citrix and Terminal Server with Sage Master Builder
	Installing on computers running Citrix and Terminal Server using DOS commands


	Sage Master Builder API
	Overview of the Sage Master Builder API
	About Sage Master Builder API
	API installation and company access
	System requirements for Sage Master Builder API
	Installing SDK samples and test programs
	About the Sage Master Builder API Administration window
	Launching the API and starting the API service
	States of the API
	Configuring the API security settings


	Enterprise Installation and Setup
	Installation and Setup Guidelines
	Pre-installation information

	Installation Steps and Procedures
	Installation steps overview
	Step 1 - Configure your server
	Step 2 - Install Sage license server to the server
	Step 3 - Log on to the License Administration Tool
	Step 4 - Activate your product license
	Step 5 - In Sage Master Builder, rebuild the indexes on any existing databases
	Step 6 - Add all companies to the Server Company List
	Step 7 - Install CodeBase Server for Sage Master Builder to the server
	Step 8 - Install CodeBase Administrator for Sage Master Builder to the server
	Step 9 - Launch CodeBase Server and then launch CodeBase Administrator and finally connect to the server for the first time
	Step 10 - Confirm and/or change your settings through Server Settings
	Step 11 - Set up user accounts through Account Management
	Step 12 - Install Sage Master Builder to each client
	Step 13 - Specify the Sage license server from each client workstation
	Step 14 - Set up and configure CodeBase Server connections for each client


	Glossary
	Glossary definitions
	administrator user
	administrator password
	API
	client workstation computer
	company folder
	computer name
	exclusive access
	firewall
	hardware failure (of the computer running the Sage license server)
	IP address
	License Administration Tool for Sage Software Products
	License Administration Tool - Available Uses column
	License Administration Tool - Product or Feature column
	License Administration Tool - Product or Feature use
	License Administration Tool - Product line
	License Administration Tool - Reservations allowed
	License Administration Tool - Reserved
	License Administration Tool - Reserved for
	License Administration Tool - Reserved under
	License Administration Tool - Status column
	License Administration Tool - Total Uses column
	License Administration Tool - Unreserved
	License Administration Tool - User name
	License Administration Tool - Version
	license
	license - expiration date
	license - floating use
	license - grace period
	license - in use
	license - in use since
	license - product
	license - reserved
	license - site
	license - unreserved
	license status - activated
	license status - expired
	license status - Not Activated
	license use
	license use - acquired
	license use - returned
	local area network (LAN)
	(dot) .NET Framework
	network
	product
	product key
	Sage license server
	Sage License Server Connection State - connected
	Sage License Server State - disconnected
	server
	Session ID
	stand-alone environment
	supervisor user
	Terminal Services
	user name
	wide area network (WAN)
	Symbols
	A
	B
	C
	date format 82
	date format 82
	date format 81
	printers 81
	date format 82

	D
	E
	F
	G
	printing

	H
	I
	documentation 90
	samples 90
	test programs 90

	L
	N
	O
	P
	R
	setup 26

	S
	T
	U
	V
	W
	Sage license server
	Sage licensing
	verify 25



	Index

